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Preface

Scope
This manual describes the operation of the TEAM Core Software applications. The informat
contained in this manual has been carefully checked and is believed to be entirely reliable. 
However, as General DataComm improves the reliability, function, and design of their produ
is possible that information may not be current. Contact General DataComm if you require up
information for this or any other General DataComm product.

General DataComm, Inc.
Technical Publications Department
6 Rubber Avenue
Naugatuck, Connecticut, USA  06770
Tel:   1 203 729 0271

About This Manual 

This manual should be read in its entirety and all procedures completely understood before
installing or operating the unit. This manual assumes a working knowledge of HP OpenView

Notes, Cautions and Warnings

The notices that appear throughout this manual must be read prior to any installation or ope
procedure.  Examples of notes, cautions and warnings used in this manual are shown below

NoteNote Indicates a note. It is something you should be particularly aware of; something not readily
apparent. A note is typically used as a suggestion.

Important Indicates an emphasized note. It is something you should be particularly aware of; someth
not readily apparent. Important is typically used to prevent equipment damage.
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TEAM Core Revision History

This release of TEAM Core Version 4.2.0 has been tested to be Year 2000 Compliant in acco
to GDC ENG-STD-003. TEAM Core 4.2.0 differs from the immediately preceding release as
follows:

• TEAM Core Version 4.2.0 can now support the SC 5516 DS0-DP product.

Preceding Versions Description of Change

TEAM Core 4.1.0 Supports the SC 5516 DSO-DP product.

TEAM Core 4.0.0 Supports the SC 7723-MR and GT 1033 Multi-Rate products.
Approved for operation on Solaris 2.7, Solaris 2.8, HP OpenView 
6.1 and HPUX 11.0

TEAM Core 3.1.0 Supports the SC 800 T3 product.

TEAM Core 3.0.5 Supports long host ID names, up to 50 characters (previously 
limited to 16), minor fixes, product compatibility additions.

TEAM Core 3.0.4 Minor fixes, Product compatibility additions.

TEAM Core 3.0.3 Minor fixes, Product compatibility additions.

TEAM Core 3.0.2 Supports Group Configuration functions.
Enhanced product compatibility.

TEAM Core 1.7 Supports the assignment of Alarm Severity.
Supports TEAM 7624 applications.

TEAM Core 1.6 Circuit submap ("managed pair") functionality.
Line Statistics Collector application.
Firmware Download application.
Support for TEAM 7000 and TEAM 700 applications.

TEAM Core 1.5 Solaris/HPOV/HPUX10.x Compatibility with Front Panel Poll Rate.

TEAM Core 1.3 Supports redundant SCM cards.
Supports Firmware Download functions. 
Revisions to Configuration screens.

TEAM Core 1.2 Provides a Power Supply Status display and Manual Discovery 
procedures. Supports E1 LTUs (32 DS0s in backplane data 
highways).
vi TEAM Core Operation Manual 058R720-V420
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Service Support and Training
VITAL Network Services is a leading single-source, data communications organization whic
provides network service and support for General DataComm customers throughout the wo
VITAL Network Services provides the support and training required to install, manage and 
maintain your GDC equipment. Training courses are available at centers in the US, UK, Fra
Singapore and Mexico, as well as at a customer’s site.

For more information on VITAL Network Services or for technical support assistance, conta
VITAL Network Services at:

VITAL Network Services World Headquarters
6 Rubber Avenue Telephones: Faxes:
Naugatuck, Connecticut 06770 USA 1 800 243 1030 1 203 723 5012

1 888 248 4825 1 203 729 7611
http//www.vitalnetsvc.com 1 203 729 2461

VITAL Network Services Regional Sales and Service Offices:

North American Region Office
6 Rubber Avenue
Naugatuck, Connecticut 06770 USA
Telephones: 1 800 243 1030

1 888 248 4825
1 203 729 2461
1 800 361 2552 (French Canadian)

Training: 1 203 729 2461
Faxes: 1 203 723 5012

1 203 729 7611

Central America, Latin America
VITAL Network Services
Periferico Sur 4225, Desp. 306
C.P. 14210, Mexico D.F., Mexico

Telephone: 52 5 645 2238
Training: 52 5 645 2238
Fax: 52 5 645 5976

Europe, Middle East, Africa
VITAL Network Services
Molly Millars Close
Molly Millars Lane
Wokingham, Berkshire RG41 2QF UK

Telephone: 44 1189 657200
Training: 44 1189 657240
Fax: 44 1189 657279

Asia Pacific
VITAL Network Services
501 Orchard Road 05-05
Wheelock Place, Singapore 238880

Telephone: 65 735 2123
Training: 65 735 2123
Fax: 65 735 6889
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Chapter 1:  Introduction to TEAM Core

Overview of TEAM Management
TEAM and TEAM Core software packages are distinct groups of HP OpenView applications
employ the Simple Network Management Protocol (SNMP) to configure and control the oper
of a wide variety of GDC product cards housed in SpectraComm or UAS shelve systems. 

Each individual TEAM software package (i.e., TEAM 521A, TEAM 800 T3, TEAM 7700, etc
controls and communicates with its associated units by means of the SpectraComm Manag
(SCM) card that occupies the shelf with those units. Each product card is described in its ow
Installation & Operation Manual, TEAM Operation Manual and Release Notes. 

The TEAM Core software package described in this manual performs functions that extend b
the product-specific TEAM applications, enabling the individual applications to function toge
in a seamless, integrated manner:

• TEAM Core applications configure the SCM for the desired functioning as the SNMP agen
units in its shelf. 

• TEAM Core applications control the HP OpenView IP node discovery application shared
the individual TEAM applications. Through discovery and mapping, an OpenView Windo
(OVW) database is built which defines the systems and equipment in the network (see C
2 for details).

• In SC 5000 systems, TEAM Core provides Shelf Configuration which determines the oper
of data highways and timeslots. Individual TEAM applications control the Multiple Data S
Emulator (DSE) cards which use the data highways on the SpectraComm shelf backpla
perform Data Terminal Equipment (DTE) interface functions and exchange data with a L
Terminating Unit (LTU) card. 

• In UAS 7000 systems, TEAM Core coordinates the all of the backplane functions.

Note Refer to Table 1-1 for a list of all TEAM-managed network elements intended for operation in a 
SpectraComm 5000 shelf system. 
Refer to Table 1-2 for TEAM-managed elements intended for use in a UAS 7000 shelf system. 
058R720-V420 TEAM Core Operation Manual 1-1
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SCM Card Overview
TEAM Core software manages and communicates with a SpectraComm Manager (SCM) us
SNMP to comprehensively manage the network. The SCM acts as the SNMP agent through
TEAM management applications communicate with units and other compatible equipment. 
SCM receives SNMP set and get commands from TEAM Core and sends equivalent 
commands to the selected unit via the shelf backplane. The SCM also generates and sends
unscheduled, unsolicited messages (or traps) to the management application in response to
occurring at the unit, especially alarm conditions. 

Management communications are directed to the SCM card Internet Protocol (IP) address. 
there the SCM card uses a slot addressing scheme to relay commands and responses betw
TEAM applications and hardware components over the SpectraComm shelf backplane. The
is transparent to the user since the TEAM applications operate as though they were commun
directly with the hardware units. 

The bus structure of the SpectraComm shelf backplane allows the SCM card to act as a sha
management agent for compatible components installed in the shelf. Daisy chain cables can
the backplane bus to a second shelf. This use of the SCM as a staging point for SNMP activ
conserves the number of Internet Protocol (IP) addresses required for management function

Network Elements Overview

The tables below list all of the TEAM-managed SpectraComm and UAS network elements th
the TEAM Core applications.  
Table 1-1 lists elements intended for a SpectraComm shelf with a SCM card at Version 5.x.x
Table 1-2 lists elements intended for a UAS shelf with a SCM card at Version 7.x.x.

Each table describes the elements as follows:

• whether TEAM Core Auto Configuration is supported

• whether TEAM Core Auto Discovery is supported

• whether TEAM Core Firmware Download is supported

• whether a Master/Remote functionality is supported 

• whether the network element is Telnet-compatible

Note To ensure all individual network element features are supported, the elements should be installed in 
proper shelf system (SC or UAS) and the associated SCM card must be at the proper version for tha
1-2 TEAM Core Operation Manual 058R720-V420
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Introduction to TEAM Core
Note ❅  Auto Configuration of the SC 5001, SC 5002 and SC 5520 consists of Highway Configuration 
     information only. 

Table 1-1 TEAM-managed SpectraComm Shelf Elements

Managed Network 
Elements

TEAM 
Application

Telnet/Craft
w/SCM

Standalone
Craft

Discover
Remotes

Auto 
Config

Firmware 
Download

Can be 
Master or 
Remote

SCM Version 5.x.x TEAM Core ✔ ✔

SC 202 Modem TEAM 202 ✔ ✔

SC V.F 28.8/33.6 
Modem

TEAM V.34 ✔ ✔ ✔

SC V.34 4-Port Modem TEAM V.34 ✔ ✔ ✔

SC V.34 DBU TEAM V.34 ✔ ✔ ✔

SC Dual V.34 Modem TEAM Dual V.34 ✔ ✔

SC 5001 T1 LTU TEAM 5001 ✔ ❅

SC 5002 E1 LTU TEAM 5002 ✔ ❅ ✔

SC 521 All Rate DDS 
DSU

TEAM 521 ✔ ✔ ✔

SC 521A DSU TEAM 521A ✔ ✔ ✔ ✔ ✔

SC 521A/S DSU TEAM 521A ✔ ✔ ✔ ✔ ✔

NMS 510 DSU TEAM 521A Remote only

NMS 520 DSU TEAM 521A Remote only

SC 5034 DSE TEAM 5034/90 ✔

SC 5090 DSE TEAM 5034/90 ✔ ✔

SC 553 T1/FT1 DSU TEAM SC 553 ✔ ✔ ✔ ✔ ✔ ✔

SC 5506 OCU-DP TEAM 5506/5516 ✔ ✔ ✔

SC 5516 DS0-DP TEAM 5506/5516 ✔ ✔ ✔

SC 5520 DSE TEAM 5520 ✔ ❅ ✔

SC 5553 DSE TEAM 5553 ✔ ✔

SC 800 T3 DSU TEAM 800 T3 ✔ ✔ ✔ ✔ ✔ ✔
058R720-V420 TEAM Core Operation Manual 1-3
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Table 1-2 TEAM-Managed UAS Shelf Elements

Managed Network 
Element

TEAM 
Application

Telnet/Craft
w/SCM

Standalone
Craft

 Discover
Remotes

Auto 
Config

Firmware 
Download

Can be Master 
or Remote

SCM Version 7.x.x TEAM Core ✔ ✔

SC 2011 DATX TEAM 2011

SC V.F 28.8/33.6 
Modem

TEAM V.34 ✔ ✔ ✔

SC V.34 4-Port 
Modem

TEAM V.34 ✔ ✔ ✔

SC V.34 DBU TEAM V.34 ✔ ✔ ✔

SC Dual V.34 Modem TEAM Dual V.34 ✔ ✔

SC 611 NTU TEAM 600

SC 613 TEAM 600

SC 616 LTU TEAM 600

DC 610 NTU TEAM 600 Remotes only

DC 612 NTU TEAM 600 Remotes only

DC 621 NTU TEAM 600 Remotes only

GT 128 NTU TEAM 600 ✔ ✔ ✔

700G2, 700G3 TEAM 700 ✔

700AG2, 700AG2NZ, 
701T2, 702G2, 
710D2, 711D2 

TEAM 700 ✔ ✔ ✔ ✔

720G1, 720G2, 
721T2, 730D1, 
730D2, 731D2, 

TEAM 700 ✔ Remotes only

GT1020, GT1030, 
GT1033 Multi-Rate, 
GT2020, GT2030, 

TEAM 700 ✔ Remotes only

7001, 7002 TEAM 7000 ✔ ✔

7022 TEAM 7000 ✔ ✔ ✔

7616, 7616MP, 
7616NZ

TEAM 7600 ✔ ✔ ✔ ✔

7624 TEAM 7600 ✔ ✔

7626 TEAM 7600 ✔ ✔ ✔ ✔

7722 TEAM 7700 ✔ ✔ ✔ ✔

7723 MR TEAM 7600 ✔ ✔ ✔ ✔
1-4 TEAM Core Operation Manual 058R720-V420
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TEAM Core Applications
TEAM Core software consists of separate applications which are grouped by their TEAM Co
function and menu that provides access to them. Note that some applications are available v
than one menu. Detailed information and procedures are provided in the chapters reference
Table 1-3.

Accessing TEAM Core Applications
The TEAM Core applications are accessed by selecting an object and then using the menu
or more of the following hierarchies: the TEAM Universe submap menu, the shelf submap me
an SCM icon, and /or an SCM Front Panel Display Select  menu. While most applications are 
available via multiple hierarchies, some applications have only one means of access. Refer tTable 
1-4, Table 1-5, and Table 1-6 to become familiar with the menu location of each TEAM Core 
application.

Although many submaps can be opened simultaneously, only one object may be selected at
with TEAM menu options in all submap windows applying to that selected object. Note that 
selected object is active  even if the submap containing the object is closed.

Table 1-3 TEAM Core Application Matrix

TEAM Core Function Application Universe Map          Shelf Submap     Front Panel
       Menu                        Menu                           Menu Reference

Performance Line Statistics ✔ Chapter 6

Front Panel ✔

Chapter 3What Are You... ✔ ✔

Power Supply Status ✔

Configuration Firmware Download ✔ Chapter 6

Maintenance ✔ ✔ ✔ Chapter 4

Shelf Configuration ✔ Chapter 5

Configure ✔ ✔ ✔ Chapter 4

Fault Poll Shelf ✔ Chapter 3

Set/Unset Time on Shelf ✔

Misc Information ✔ ✔

Chapter 3
Alarm Severity ✔ ✔

Front Panel Poll Rate ✔ ✔

Note Pad ✔

Demand Poll and Auto Poll ✔ Chapter 3
058R720-V420 TEAM Core Operation Manual 1-5
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TEAM Universe Map Menu

The table below depicts TEAM Core applications which can be accessed from the HPOV men
Select the object you intend to work with by clicking once on its icon. Then select the desire
TEAM Core application from the Universe submap menu. Refer to subsequent chapters for d
application descriptions and procedures.

Table 1-4 TEAM Applications Accessed from the Universe Map 

Universe Map Menu TEAM Core Applications Description

Performance Line Statistics... Configures an SCM to collect statistics from selected device 
types in the TEAM Universe.

Configuration Firmware Download... Downloads new firmware to devices in the SpectraComm 
shelves, as well as remote units linked to those devices. 

Shelf Configuration... Configures backplane data highway and timing parameters 
required for an SC 5000 system.

Fault Reset Power Supply Status Resets a power supply alarm monitor and recalculates wattage 
statistics.

Poll Shelf... Demands an SCM poll its shelf to discover new cards and 
redraw the Shelf submap.

Set Time on Shelf... Enables or Disables a periodic time signalling scheme to 
synchronize an SCM and the devices under its management.

UnSet Time on Shelf...

Misc Agent Templates... Not active for SCM-managed applications

Information... Read-only information on the TEAM application software 
version and copyright 

Alarm Severity... Assigns a severity category (Major, Minor, or Warning) to each 
alarm for each equipment type.

Front Panel Poll Rate... Sets a default polling interval which takes effect each time the 
Front Panel display is opened. 

Note The Agent Templates are used only by stand-alone products (TEAM 540, TEAM 553, etc.) and are
cussed only in documentation accompanying those products. 
1-6 TEAM Core Operation Manual 058R720-V420
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Shelf Submap Menu

The table below depicts TEAM Core applications which can be accessed from the shelf sub
HPOV menu bar. Select the desired SCM by clicking once on its labeled icon at the bottom 
shelf slot. Then select the desired TEAM Core application from the shelf submap menu. Re
subsequent chapters for detailed application descriptions and procedures. 

Table 1-5 TEAM Applications Accessed from the Shelf Submap Map

Shelf Submap Menu TEAM Core Applications Description

Performance Front Panel... With an SCM icon selected, launches an SCM 
Front Panel display with status LEDs and a Select 
menu for accessing TEAM Core applications.

With a Power Supply icon selected, launches a 
Front Panel display for the Power Supply.

What Are You... Brief read-only information SCM software and 
MIB versions, as read from the database and 
from the SCM.

Power Supply Status... Displays a power supply front panel display with 
two usage indicators: watts required by the SCM-
managed devices and available wattage in the 
shelf.

Configuration Configure... Configures an SCM with IP addressing and 
routing. 
Displays expanded read-only SCM software 
information.

Maintenance... Sets up the Time, Date and the Alarm Scan 
status for an SCM.

Misc Information... Brief read-only information on the TEAM Core 
software version and copyright 

*Alarm Severity... Assigns a severity category (Major, Minor, or 
Warning) to individual alarms for each equipment 
type.

*Front Panel Poll Rate... Sets a default polling interval which takes effect 
each time the Front Panel display is opened. 

Note Pad... Opens a shell tool for running a text editor, mail 
tool or other method for keeping records on the 
system.
058R720-V420 TEAM Core Operation Manual 1-7
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The SCM Front Panel Select Menu

The Front Panel display is an application of TEAM Core which also provides menu access t
rest of the TEAM Core applications. At the Shelf submap Performance menu, select Front 
Panel  from the menu, then click on the Select  button to display an embedded menu of seve
TEAM Core applications. The following table briefly describes the applications as they appe
the Select menu. Refer to subsequent chapters for detailed application descriptions and proc

Table 1-6 TEAM Applications Accessed from the SCM Front Panel

Select Button 
Menu Items

TEAM Core 
Applications

Description

Performance What Are You?... Brief read-only information about SCM software and 
MIB versions.

Configuration Configure... Configures an SCM with IP addressing and routing. 
Provides expanded read-only SCM software 
information.

Maintenance... Sets the Alarm Scan status for an SCM.

Demand Poll Activates an immediate update of the SCM Front Panel LEDs. 

Auto Poll
Sets an interval for the Front Panel display update:
15, 30, 60 seconds, or Disable.

Exit Dismisses the Front Panel application.
1-8 TEAM Core Operation Manual 058R720-V420
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Window Features in TEAM Applications

The example screens below describe the window features that are common to all TEAM Co
application windows and their subordinate windows. For more information on a specific applic
and its procedures, refer to Chapters 3 - 6.

Table 1-7 Typical Application Window Features

Window Feature Description

Title bar Identifies the specific TEAM application running in the window, i.e., Group 
Configuration, Firmware Download, etc. 

Triangle button Click to minimize window to an icon; double-click to restore. Available only 
when TEAM software is running on a SUN workstation under HP OpenView 
and when the user has defined the required window manager settings. 

Menu bar Provides menus for application-specific utilities along with common utilities, 
such as File->Exit and Help. Located under the Title Bar.

Name field Identifies the SCM currently communicating with TEAM Core by displaying 
the shelf name, and SCM card slot number. Located below the menu bar.

Command buttons
Function buttons

Click command buttons to execute a command instantly, such as Reset, 
Cancel or OK. and Add. Click a function button to advance to a sub-window. 

Pulldown lists Pulldown and scroll to select options for equipment types, function 
parameters or operation controls for the application.

Gyphs Click empty gyphs to select options, click filled gylphs to deselect.

Entry Fields Click to activate entry field for user-defined data, such as IP addresses, 
shelf names, system information.

Multiple Select buttons Allow global select and deselect of frequently grouped options.

Data Display Window panel for displaying read-only information or selectable data.

Note Grayed-out buttons, fields, or lists represent options that are disabled or not available with the curre
SCM configuration. Refer to Chapter 4 for setting SCM Configuration parameters.

Selection
Gylphs

Function
Button

Sub-window 
Title Bar

Entry Field
Pulldown List

Data
Display

Multiple Select
Buttons

Selection
Gylphs

Pulldown Lists

Command Buttons

Top-level
Title Bar &
Menu Bar
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Chapter 2:  Discovery & Mapping

Discovery

The Discovery function searches for devices on the network and is integrated with the Open
IP node discovery application. Once an SCM card is discovered, the SCM is polled using the S
Network Management Protocol (SNMP). The information gathered is used to build objects i
OpenView Windows (OVW) database. The objects represent cards in the shelf being monito
the SCM. 

Once devices are discovered, the network topology is displayed in hierarchical object maps
proceed from general to specific: Root Map, Universe Map, Shelf Map, Element Map, Conne
Map and Circuit Map. Each map reveals a more detailed view of a smaller part of the 
communications system. 

Auto-Discovery

TEAM Core uses Auto Discovery as the default discovery process. In this process, TEAM C
polls each new device it encounters in order to identify an SCM card. Once an SCM card is de
Auto-discovery conducts further polling through the SCM using SNMP to build objects and 
construct maps in the OpenView Windows (OVW) database. The objects represent the SCM
managed network elements in the shelf. Likewise, network elements in the shelf that suppor
Discovery will autodiscover their associated remotes. 

Manual Discovery

In situations where network size or data traffic requirements are a consideration, a manual dis
may be preferable to Auto Discovery. Auto Discovery may burden such networks, reducing 
throughput of payload data. By disabling Auto Discovery, the user can identify for the TEAM
applications a specific SCM to poll and thereby construct a shelf submap for it and the devic
controls. This manual method of discovery introduces less data traffic on the network by requ
only the routing tables of the specified SCM. 

Note The default Auto-discovery is disabled by turning off HP OpenView polling. This is accomplished by 
disabling the TEAM Core netmon function or through the Options->Network Polling 
Configuration  function. Disabling Auto-discovery by either method activates TEAM Core’s man
discovery process, described below.

Note In environments, such as DDS I that use the same channel for both primary and management data, 
Discovery and Alarm Synchronization functions can interfere with primary data flow while they are run
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Manual Discovery Procedures

Enable Manual Discovery by Stopping Netmon

Within the TEAM application, operation of the auto-discovery process is governed by a Loca
Registration File (LRF) called discover.lrf  that is located in the  /usr/OV/lrf  directory. 
To disable auto-discovery by turning off netmon you need to modify that file as follows: 

1. Open a shell tool on your workstation. 

2. Stop the Shelf Discovery process by typing:
/opt/OV/bin/ovstop shelf_discovery

3. Make a backup copy of the discover.lrf  file so that it can be reloaded later in its origina
form if needed. 

4. Load the discover.lrf  file into an editor so that you can modify it. 

5. Locate the following two lines in the file
/opt/OV/bin/shelf_discovery:
OVs_YES_START:trapd,ovwdb,netmon::OVs_WELL_BEHAVED:15

6. Delete ,netmon  from the second line and save the file. The two lines should now read: 
/opt/OV/bin/shelf_discovery:
OVs_YES_START:trapd,ovwdb::OVs_WELL_BEHAVED:15

7. Update the process configuration by running OpenView Add Object on the discover.lrf fil
typing: 
/opt/OV/bin/ovaddobj /usr/OV/lrf/discover.lrf

8. Restart the Shelf Discovery process by typing:
/opt/OV/bin/ovstart shelf_discovery

9. Proceed to the Perform Manual Discovery procedure.

Enable Manual Discovery by Turning Off OpenView Polling

The auto-discovery process is part of the larger Status Polling procedure carried out by the 
OpenView software. To disable auto-discovery by controlling OpenView polling, carry out th
following steps:

1. Display the Universe submap. 

2. From the Options menu, select Network Polling Configuration:IP . 
A dialog box appears.

3. Suspend all automatic polling by deselecting Perform Status Polling .
Suspend only polling for the discovery process by deselecting Discover New Modes . 

4. Dismiss the dialog box. 

5. Proceed to the Perform Manual Discovery procedure.
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Perform Manual Discovery
After disabling auto-discovery as described above, an SCM can be manually discovered. Befo
can occur, the SCM must be configured with the appropriate community name and must be
available for communication. To perform manual discovery carry out the following steps:

1. At the Options menu, select SNMP Configuration .

2. Make sure that the SCM is showing the proper Community Configuration. 

3. Make sure communication is possible with the SCM by pinging it and issuing an snmpwalk  
command. If this does not work, check the routing tables in the workstation to make sure
is a route available to the SCM. 

4. Display the IP submap of the segment to which the SCM is connected. 

5. From the Edit menu, select Add Objects . 

6. In the resulting window select the Computer  symbol class. 

7. Modify the symbol by using the middle mouse button to drag the SCM Symbol Subclass onto it 
on the IP submap. 

8. In the Add Objects dialog box, enter the label assigned to the SCM. 

9. Set the IP Map Object Attributes. Be sure to enter both the hostname and the IP addres

10. When the process is completed, the Shelf Discovery application polls the SCM and draw
shelf topology based on the information it receives from the SCM. 

Note If a valid hostname is not available, enter the IP address of the SCM in the Hostname field. 

Note The Read and Write Community Names which are set in HPOV SNMP Configuration must match the
configured Community Names on the SCM. If they are incorrect, Discovery is unable to poll or updat
SCM.  The SNMP Configuration selection appears in the Options menu of the HPOV menu bar which a
at the top of all map windows. 
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Mapping

After discovery of TEAM-compatible hardware systems in the network, a network topology i
created from the OVW database.  This topology is described by a series of hierarchical objec
that proceed from general to specific: Root Map, Universe Map, Shelf Map, Element Map, 
Connection Map and Circuit Map. Each map reveals a more detailed view of a smaller part 
communications system, as described below and in Figure 2-1.  

Root Map

The Root map is at the top of the hierarchy, containing the TEAM icon and the IP Internet icon
TEAM icon accesses all applications integrated with the TEAM Core. The IP Internet icon acc
a map of the workstation’s communication environment. The Root map can also contain a T
Standalone icon if there are standalone applications installed on the workstation (TEAM 553
TEAM 540, etc.) and the devices they control. These standalone applications communicate
individually with the workstation and do not employ the SCM card or the shared core functio

Universe Map

Open the Universe map by double-clicking the TEAM icon in the Root map. The Universe m
consists of one shelf icon for each SCM-equipped shelf communicating with the workstation
Universe map can show lines between devices and/or shelves, designating that they are lin
have been configured by the user to be linked (refer to Chapter 2 and Chapter 4 for  proced
The Universe map can show the following links:

• a dedicated remote device joined by a line to the shelf containing its master unit

• a shelf-resident devices, such as the SC 521 DSU, joined by a line to a dedicated remote

• a shelf joined by a line to other shelves 

• a standalone remote device joined by a line to shelf devices appearing in the Universe m

Shelf Map

Open a Shelf submap by double-clicking on its shelf icon in the Universe map. The Shelf su
is generated from the OVW database. It is an integrated application under HPOV which disp
the shelf and its installed individual devices. Since it is an OpenView appication, the Shelf ma
only when executed by OpenView, starting up when OpenView Windows starts. In the Shelf
each TEAM compatible device has an selectable, octagonal device icon at the bottom of the
image. The Shelf map is used to perform the following functions:

• update the topology view in response to received traps

• create and maintain shelf background and shelf content images

• open shelf icons and associated submaps (described in the following paragraphs)

Connection Map

A Connection map is opened by double-clicking the line that connects two shelves in the Un
map. This map displays all individual circuits established between the two shelves. Each cir
represented by the icons for its devices, connected to each other by lines that represent the
communication path.  Icons are automatically added as new circuits are configured.
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Circuit Map

The Circuit map is created by the user to displays the link between two devices and to prov
convenient point of access for launching applications at both ends of a link. If the same she
resident device type is at both ends of the link, the two devices can be selected together so
applications for both are launched by a single menu selection. If the circuit map is of a shelf re
device linked to a standalone device, their applications have to be launched separately. 

Note A Circuit map should not be created for devices that are associated by means of an Add (or Wake Up) 
configuration function.

.

Figure 2-1 Map Hierarchy
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 Individual Device icons

A device icon represents a specific unit in a shelf. Click on an individual device icon to activ
menu bar for TEAM applications specific to the selected unit.  The user can select multiple i
of the same type in order to launch multiple application windows simultaneously.  A device i
with a border will open to a Circuit submap if one has been created. A device icon without a b
indicates a unit with a dedicated remote and an associated Element submap. Double-click o
device icon to launch the selected unit’s Front Panel display or Element submap.

Element Submap

Double-clicking on any device icon without a border opens the Element map. This map whic
displays the link between the master device in the shelf and its remote(s). The link can be p
point or multipoint. The remotes in an Element map are devices that cannot communicate 
independently with the TEAM controller workstation. The Element map is created automatic
by the configuration function that associates the remote(s) with the master unit.

Dedicated Remote icon

Dedicated standalone remote units are user-configured to be linked with shelf-resident maste
They are TEAM software controlled only when linked with a master unit.  Double-click a dedic
remote icon to open the unit’s Front Panel.  The icon is labeled with the slot:line:drop address
slot identifies the master unit in the shelf. When selected/highlighted the menu bar is active 
TEAM applications specific to the selected unit.

Power Supply Icon

Double-click the Power Supply icon to open the Power Supply Front Panel.

SCM Device icons

Double-click to open the SCM Front panel. When selected/highlighted, the menu bar is activ
SCM and Core functions.  

Map Symbols

The Root symbol accesses the system in OpenView. It is the highest level in the Submap hie
This symbol is created in the OpenView Root Submap. Access the Universe submap by do
clicking on this symbol.

The Shelf symbol is the logical representation of the SpectraComm Shelf in the Network. Ea
physical shelf on the network has a corresponding Shelf symbol in the Map. This symbol repr
the SCM card plus all the cards in the shelf. Access the Shelf submap by double clicking on
symbol.

The SCM symbol represents the SCM card in the SpectraComm Shelf. This symbol is creat
two places when the SCM is discovered by netmon: 

• IP Map creates an SCM symbol in the Internet Submap 

• Shelf map creates an SCM symbol on the Shelf Submap, representing the SCM c
within the shelf. The status source for this symbol is set to Compound (Propagate)
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Mapping Procedures

Creating a Circuit Map

Unlike other self-generating maps that display portions of the TEAM universe, circuit maps 
created by the user. Do not create a Circuit map for master and dedicated remote devices t
associated by means of an Add (or Wake Up) Remote configuration function. The configura
function automatically creates an Element map for those devices. 

To create a Circuit map:

1. Open the two maps that contain the ends of the circuit to be mapped. At least one of tho
maps must be a Shelf map. If the Circuit map is to contain a standalone device, you nee
open the TEAM Standalone icon in the Root map to access the icon for that device. 

2. Select the shelf resident device that is to be one end of the circuit and the basis of the m
both ends of the circuit are to be shelf resident devices, you can start with either end. If on
is a standalone device, you must begin with the shelf resident device. 

3. Select Create Circuit Submap... from the menu bar Configuration menu. A circui
map is displayed which contains one icon to represent the selected device. 

4. Select the icon for the device that is to be the second end of the link. From that device’s
menu, select Copy: From This Submap .

5. Click in the new Circuit map. From its Edit menu, select Paste . When the second icon is 
pasted into the map, the application automatically adds the line that represents the conn
between the two devices. 

Note The TEAM Core application will allow the user to specify any two devices as the ends of a circuit. Mak
that the created Circuit map accurately represents a real communication link.

Shelf Map Background Image

The Shelf map application can be configured to represent the SpectraComm Shelf and its co
in an OpenView background image. The image is synchronized with the current shelf configu
and displays the shelf with all SCM cards in the proper locations. Shelf submap symbols are a
with their corresponding card image in the background image. The default configuration ena
background graphics. You can set this capability by using the Shelf Map Configuration Dialog
which is accessed as follows:       

For HPOVWv5.x:

Map->Maps...->Describe/Modify:Shelf Map:Configure For This Map...

For HPOVWv6.x:

Map->Properties...->Shelf Map:Configure For This Map...
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Shelf Map Synchronization

Shelf Map synchronization occurs when the Shelf map application is started. During 
synchronization, OpenView displays a Synchronizing  message on the status line of any 
displayed submaps. The Shelf map creates symbols for new network objects to update the S
that use the database and to update alarm status. Note that the Shelf map will not appear in
of applications on opening dialog boxes until initial synchronization is completed. At that poin
Shelf map accepts and handles incoming OpenView events and topology changes.

The Shelf map application also displays the synchronizing message during lengthy operation
as updating a shelf graphic. Since the Shelf map synchronizes in conjunction with other Ope
applications, the synchronization message will also display when any one of these applicatio
synchronizing.

Note During synchronization, the Shelf map application cannot respond to some OpenView requests or us
requests, such as deleting symbols and objects. 

Shelf Map Editing

The Shelf Map allows the user to Add, Delete and Cut/Paste map symbols via the OpenVie
interface.  Note that these operations are not available during map synchronization. Refer to 
OpenView User’s Guide for additional details. 

• Adding symbols involves both icon and connection symbols which are accessed via diffe
menu items in OpenView. The Shelf Map function does not accept additions of icon or 
connection symbols on the application plane of the map. However, you can to add any s
to the user plane.

• Deleting a symbol from the map also deletes it from the SCM tables. 

• The Cut/Paste function permits the pasting of a symbol in the user plane of the map. The
of the symbol is kept synchronized with the device it represents. 

Note Exercise care in deleting symbols from the shelf map. If a device symbol is deleted in error, power to
device has to be cycled before the device can be discovered and its symbol restored to the map. 

Shelf Submap Editing

The Shelf symbols on the TEAM Universe submap provide access to Shelf Submaps.  A Sh
Submap contains a symbol for each card in the corresponding shelf. The SCM card proxies 
messages to the other cards in the shelf. It also maintains a table of all cards in the Shelf. U
shelf submap to delete a card or other device completely from the system, as described bel

Note Note that physically removing a card from a shelf or disconnecting a device from the system does no
it from the Shelf Submap. 

1. Remove the card or other device from the SCM Node Table. In the case of a central site d
that means physically removing the card from the shelf. In the case of a remote device, 
means disconnecting it. 

2. At the TEAM workstation, select the shelf from the Shelf Submap. Select the device you
deleting, pull down the Edit menu, and select Delete . 
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Universe Map Editing
The TEAM Universe submap is accessed through the Root symbol in the OpenView Root Su
There is only one Universe submap on each map. It contains a symbol for each SpectraCom
discovered. 

These Shelf symbols can be modified using the Describe/Modify Object Dialog Box. The lab
the system is the text name as assigned in the system configuration application. Events in the
Category application reference the shelf selection name as the source of the event.

Identifying an SCM
If HPOV Discovery is run before the TEAM application is installed, an SCM may be discove
and added to the IP submap as a generic object. This sometimes occurs during a new syste
Identified as a generic object, the SCM will not be discovered or available when the TEAM 
applications are subsequently installed. To properly identify the SCM, perform the following

1. Delete the SCM generic object.

2. Ping the device so that the SCM is properly discovered and identified by an SCM object
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Chapter 3:  TEAM Core Applications

The TEAM Core Applications

This chapter describes the TEAM Core applications that are grouped under the Performanc
Miscellaneous and Fault menus of the HPOV menu bar, as follows: 

 Performance Applications

• SCM Front Panel Application

• What Are You window

• Information window

• Poll Rate Application

Miscellaneous Applications

• Alarm Severity Application

• Power Supply Front Panel

• Information Application

• Note Pad Application

Fault Applications

• Poll Shelf Application

• Set/Unset Time on Shelf Application

Additional TEAM Core Applications

The remaining TEAM Core applications are described in subsequent chapters:

• Chapter 4: SCM Configuration Application

• Chapter 5: Shelf Configuration Application and 
Maintenance Application

• Chapter 6: TEAM Core Utilities
Firmware Download Application
Group Configuration Application
Line Statistics Collector Application
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Front Panel Application
Clicking the Performance menu Front Panel  selection opens the Front Panel display for a 
selected SCM. Table 3-1 describes the LEDs and icons on the display. Front Panel procedure
described below.  

Table 3-1 SCM Front Panel Selections

Front Panel Display LEDs / Icons Description

GDC logo Displays version information of the unit when clicked.

SD LAN
RD LAN

Send or Receive Data LAN indicates transitions while the SCM is 
sending/receiving management data through its LAN port to/from the 
TEAM workstation. 

SD WAN
RD WAN

Send or Receive Data WAN indicates transitions while the SCM is 
sending/receiving management data through its WAN port to/from the 
TEAM workstation.

ND Network Data indicates transitions while the SCM is sending 
management data on the shelf backplane to/from a device it controls.

NR Network Response indicates transitions while the SCM is receiving 
management data on the shelf backplane to/from a device it controls.

INS Illuminates green to indicate proper In Service operation.

ON LED Power on 

TM LED Test Mode illuminates bright red while the SCM performs its Power 
ON test sequence. 

ALM LED Indicates an alarm condition; color of LED reports the highest priority 
of alarm occurring at the SCM.
     Orange for a major alarm
     Yellow for a minor alarm
     Green for an informational alarm
     Dark red for no alarm conditions in the SCM.

Select Button 
Menu

Performance... What Are You? displays the software versions of the 
SCM software and MIB.

Configuration... Accesses the Configure and Maintenance 
applications. (Refer to chapter 4 for application details.) 

Demand Poll updates the LED states by polling the unit on-demand. 
At the bottom of the display, the time of the last poll is displayed in 
white. A yellow display indicates auto polling is disabled.

Auto Poll sets the polling interval:
     15, 30, 60 seconds or Disable

Exit Dismisses the Front Panel display.
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Front Panel Procedures

1. Select the SCM you intend to work with in the HPOV shelf submap window. Then, at the
Performance menu, select Front Panel .

2. As an alternate method,  double click the mouse on the slot icon for the unit. A display o
selected SCM Front Panel appears.

3. If working with remote units:
On the shelf submap, a boxed slot icon indicates no associated remotes and an unboxe
indicates a master device that has an associated remote. Double-click on the slot icon w
remote to open the link submap. Then double-click on the desired icon in this link subma
access the unit’s Front Panel display.

4. Note that each time the Front Panel display of an SCM is launched, its initial polling rate
determined by the Front Panel Poll Rate selection of the submap window Misc menu.

5. The Front Panel LEDs reflect the states of the actual indicators on the SCM card in the 

• Bright green LED indicates ON

• Bright green with a double arrow indicates transition events. 

• Dark green indicates OFF

6. From the Front Panel display, use the select button to access the other TEAM applicatio
the SCM. 

 What Are You Window

The What Are You? window is accessed from the Front Panel Select menu or from the shelf s
Performance menu of a selected SCM. It displays the read-only software information relating
selected unit.

Table 3-2 SCM What Are You? Window

Typical Display Fields/Selections Description

Name Identifies the SCM currently communicating 
with TEAM Core by displaying the shelf 
name, and SCM card slot number, as read 
from the SCM.

Software Revision Displays the revision level of the SCM 
operating software, as read from the 
database.

Boot S/W Revision Displays the revision level of the SCM boot 
software, as read from the database.

MIB Version Displays the revision level of the 
Management Information Base (MIB) file 
that enabled SNMP control of the SCM 
card, as read from the database.
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Power Supply Status Window

With a power supply icon selected at the shelf submap, click the Performance menu Front 
Panel  selection to open a generic power supply status window. This application can also b
accessed by a double-click on the power supply icon in the shelf submap. When the applica
launched, it polls the shelf to identify managed devices and determine the power requiremen
read-only status window displays graphed and numeric power usage information for the shel
the scale of the graph adjusted based on the following factors:

• type of shelf (16-slot or 10-slot)

• type of power supply (single or redundant)

• single shelf or two-shelf installation 

Table 3-3 Power Supply Status Window

Typical Power Supply Status Indicators/Selections Description

Power ON Indicated power is supplied to the unit.

Fail Indicates a failure condition.

Power Consumed Bar graph display of the total power 
requirement for all SCM-managed devices 
in the shelf (or shelves) as compared to the 
wattage available.

Watts Numeric display of Watts required to 
operate SCM-managed devices in the shelf 
or shelves.

Select Menu Demand Poll permits an additional single 
poll of the shelf on demand only.

Auto Poll selects the intervals for polling the 
shelf at: 15, 30, 60 seconds or Disable.

Exit dismisses the Power Supply Status 
Window.
3-4 TEAM Core Operation Manual 058R720-V420
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Special Considerations
• The application receives information on the current state of the power supplies without h

to poll the shelf, since the SCM generates traps in response to the addition, removal, or 
of a power supply. 

• The displayed bar graph is updated whenever a power supply is added or removed. 

• The height of the bar on the graph represents the portion of the available wattage requir
operate the SCM-managed devices in the shelves. The presence of any non-managed de
not reflected by the display. 

• The following maximum Watt values can appear on the bar graph:

Max. Watts Shelf Characteristics

100 10-slot shelf

96 16-slot shelf with a single power supply

192 16-slot shelf with a redundant power supply

192 Pair of 16-slot shelves with a single power supply

288 Pair of 16-slot shelves with a redundant power supply in one shelf and a single 
power supply in the other

384 Pair of 16-slot shelves with a redundant power supply in each
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Miscellaneous Applications

Alarm Severity

The Alarm Severity window is accessed from the Misc menu of any HPOV submap. This 
application allows you to designate a severity for each alarm type as it is reported by each d
type (such as a SC 553 or UAS 7624). These designations will apply to all devices of the se
type. When an alarm is designated with a Major, Minor or Warning severity at this window, t
Alarm Detail window and the product icon symbol will report the alarms by color-coded seve

• Orange LEDs or symbols report a major alarm.

• Yellow LEDs or symbols report a minor alarm.

• Blue LEDs or symbols report an alarm warning.

The Alarm Severity window, shown below, has one menu, File, and three scroll boxes that a
labeled with the individual severity categories. Directions for assigning severities to alarms fo
the figure. 

Figure 3-1 Alarm Severity Window

Alarm Severity Menus

The File menu provides a Save to File option for activating and saving pending Alarm 
Severity settings. The Refresh  option discards unsaved setting without closing the Alarm 
Severity window. The Reset to Defaults  option restores Alarm Severity settings to the 
stored defaults stored for the selected device type. An Exit  command dismisses the application
window.
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Alarm Severity Procedures

1. Click on the Equipment Type  field and select the device type you need to work with. 
While you hold the button down, the field displays the list of device types for which alarm
severities can be adjusted. The three scroll boxes display the current severity assignme
the alarms that the selected device type can report. 

2. To cancel out all previous assignments made by the Alarm Severity application, select Reset 
To Defaults  from the File menu. 

3. Position the pointer on the desired alarm, then click and drag the mouse into the desired
severity scroll box. Then release the button. The alarm condition name is transferred int
new scroll box. 

4. Repeat step 3 for each alarm condition you need to change. When you’re done making 
changes, select Save To File  from the File menu. 

5. Dismiss the Alarm Severity window by selecting Exit  from the File menu. The severity 
designations you have made will remain in effect until they are changed. 

Note Not all TEAM applications support the Alarm Severity function. Refer to the specific TEAM applicatio
Release Notes to determine whether its Alarm Detail window identifies alarms by severity. 

Information Application

The Information application is accessed only from the HPOV menu bar Misc menu when a sh
SCM is selected. It displays the TEAM Core version and copyright information related to the
selected unit. The window File menu provides an Exit  selection for dismissing the window.

Note Pad Application

The Note Pad application opens a shell tool which provides a text editor on the workstation ru
the TEAM software. Typically, Note Pad is used to keep records on the system. 

Agent Templates

This application may appear on some Miscellaneous menus but will be inactive and appear g
out for SCM-managed applications.
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TEAM Front Panel Poll Rate Application

The Front Panel Poll Rate application is accessed only from the HPOV menu bar Misc men
poll rate selected in this window globally determines the initial polling rate for all Front Pane
displays linked to a TEAM Core application, regardless of which individual application is acce
the unit. The initial polling rate is activated each time a Front Panel opened. The Front Pane
Rate window is shown and described below.

Figure 3-2 TEAM Front Panel Poll Rate

TEAM Front Panel Poll Rate Menus

The File menu provides a Save to File option for saving polling instructions or data for futur
use, and an Exit  command which dismisses the application window.

TEAM Front Panel Poll Rate Procedures

1. Click on the desired poll rate checkbox to set the Front Panel poll rate globally for all TE
applications: Slow, Normal, Fast or Demand Poll Only. 

2. From the File menu, select Save to File  to store the setting for use by all TEAM 
applications.

3. From the File menu, select Exit  to dismiss the application window.

Note The polling rate for an individual unit can be temporarily changed by using its Front Panel Select men
enable Auto Poll. The changed rate will be in effect for that unit only for the duration of the session, an
be discarded when the Front Panel display is closed. 

Table 3-4 TEAM Front Panel Poll Rate Window

Typical Display Selections Description

Slow Globally sets the initial polling rate to obtain 
the most precise polling frequency.

Normal Globally sets the initial polling rate to obtain 
a normal polling frequency using a normal 
allocation of resources. 

Fast Globally sets the initial polling rate to a high 
polling frequency while allocating more 
communication and processing resources 
to maintaining the display.

Demand Poll Only Allows one poll at a time, on demand.
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Fault Applications
TEAM Core includes three applications from the Fault menu of the Universe map. These 
applications are described below

Poll Shelf

The Poll Shelf menu selection instructs the core application to have the SCM card poll its sh
detect the presence of any newly installed cards that are subject to control by the SCM. If the 
detects one or more newly installed cards, the application redraws the Shelf submap. 

Normally the process of updating the Shelf submap occurs automatically as cards are installe
Poll Shelf feature is provided as a backup mechanism for the automatic functionality. 

Set/Unset Time on Shelf

The menu selection Set Time on Shelf turns on a process by which every night at midnight 
application sends a time signal to the SCM card in the selected shelf. The SCM card synchr
its time keeping functions to that signal and broadcasts a time signal to the units it controls s
they are also synchronized. The menu selection Unset Time on Shelf turns off the process. 

Reset Power Supply Status

The Reset Power Supply Status resets a power supply alarm monitor and recalculates watt
statistics.
058R720-V420 TEAM Core Operation Manual 3-9
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Chapter 4: SCM Configuration

Overview
The SCM Configuration application provides a tool for configuring the SCM with Internetwor
Protocol (IP) addressing and routing for the SpectraComm Manager (SCM) card. This applic
also specifies trap destinations. You must insure that these characteristics are properly set i
for the SCM card to perform its communication interface functions between the TEAM applic
workstation and the units it controls. 

Using Configuration Templates

Configuration procedures are described below. Throughout the text descriptions in this chap
default values will be shown in Bold . Accompanying screens are representative and may app
differently on your system. Once a configuration has been defined for a desired unit function
it can be stored as a template on the workstation that runs the TEAM application. Any numb
templates can be stored for retrieval when particular configuration settings are needed. 

The three template functions (Save, Load and Compare) are accessed via the File menu. W
select a template function, a dialog window appears for specifying the template file name. To
configuration templates refer to the basic configuration steps below. 

To load configuration settings from an existing template into the SCM, perform the following s

1. Select Load Template  from the File menu and select the template from the resulting 
dialog window. The application retrieves the configuration settings of the selected templa

2. Select Save to Unit  from the File menu. The application makes the template 
configuration settings the current operating configuration for the unit.

3. Select Compare from the File menu to compare the screen’s configuration data to a spec
template.

Note In versions of the TEAM Core software prior to Version 1.3, the configuration parameters that are n
set by SCM Configuration were subject to the Agent Configuration function. 
058R720-V420 TEAM Core Operation Manual 4-1
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SCM Main Configuration Window

The main SCM Configuration window is launched from a unit’s Front Panel Select menu or 
selecting an SCM symbol on the shelf submap and then selecting Configure  from the 
Configuration menu. When the main Configuration window opens, the application reads the c
SCM configuration from the unit. The following figure and tables describe the SCM Configura
display and menus. Configuration procedures follow the tables. 

Main Configuration Window Display

Name is a read-only field that displays the IP Hostname of the SCM in the shelf and the slot nu
of the selected unit. This field appears with the same designation on all other subordinate s
A Message  area displays application activity and unit interaction in the lower left of the wind

Table 4-1 Configuration Window Display Fields 

Fields Items Description

User Data System Name Used to identify the SCM card and its shelf.

System Location Used to identify the site address of the SCM card and its shelf.

System Contact Used to identify the name and telephone number of on-site personnel 
responsible for maintenance of shelf equipment administered by the SCM card.

Software
Data

(Read-
only)

System Uptime Displays time elapsed since the last time a reset was performed or power was 
cycled at the SCM

System Description Displays “SpectraComm Manager (SCM)”

Serial Number Displays the SCM card serial number.

Boot Version Displays revision level of the firmware boot-up code installed in the SCM 

Application Version Displays revision level of the firmware application code installed in the SCM 

GDC-SCM MIB Version Displays revision level of the MIB files installed in the SCM for control of the 
SCM 

GDC-CMN MIB Version Displays the revision level of the Common MIB files installed in the SCM

Data Entry

Read-only
Software Data

Menu bar

Messages

Read-only

Display
Fields

Name

Minimize
Button
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Main Configuration Window Menus

The main Configuration window menu bar provides a File and Navigate menu for configurin
selected SCM. Use the Navigate  menu to select the individual configuration option windows f
change. Use the File  menu for storage and retrieval of previously stored configuration templ
Table 4-2 describes the menu selections.

SCM Configuration Procedures

1. Click on the Navigate  button to display a menu of SCM configuration windows.

2. Select the first one in which you intend to make changes. In each configuration window,
on the desired input fields to open a list of available values for each option, then click on
desired value. 

3. You can discard changes made in a configuration window and return all its fields to their s
values in two ways:

• Click on the Reset  button to discard changes while keeping the window open

• Click on the Cancel  button to discard changes and close the window. 

Table 4-2 Main Configuration Menu Selections 

Menu 
Buttons

Selections Description

File Refresh Causes all option settings to be read from the unit. Any 
pending edits are lost.

Save to Unit Causes all outstanding edits to be sent to the unit.

Load Template Allows the selection of an existing SCM template to be 
applied as edits to the current application. Your next 
File-->Save to Unit  implements the template 
changes.

Save to Template Configuration data is saved as a specific template.

Compare to Template You can select an existing SCM template to be compared 
with the screen display.

Exit Terminates application with outstanding edits discarded first.

Navigate Redundant SCM Options Sets options that control the use of two SCMs in a primary 
and backup arrangement.
Sets the frequency at which Alive Traps are generated.

Trap Options Sets options for trap addressing and criteria for generating 
and receiving traps.

IP Routing Options Displays and edits IP Routing table.

Community Name Options Sets community names and access options. 

Misc SCM Options Enables/Disables firmware download and Telnet 
communications. 

All Screens... Displays all subordinate windows of the SCM Configuration 
application

Help Displays the Help on-line manual.
058R720-V420 TEAM Core Operation Manual 4-3
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4. Close a configuration window without losing changes by clicking on either the OK button or 
the push-pin glyph in the upper left corner of the window.

5. Continue to select other configuration windows to make additional changes. Refer to the
following sections of this chapter for descriptions of each configuration window menu an
selectable options.

6. When you have accessed all the configuration windows for changes, use the main 
configuration window File menu to save all changes. Select Save to Unit  to send the 
changes to the unit as the new current configuration. This activates the changes instantly
unit.

7. If you attempt to Exit from SCM Configuration without having saved configuration chang
pop-up window appears with the message: 

APPLICATION HAS PENDING EDITS. 
The following screens have pending edits: 
Discard Edits and Exit Application? 

If you click on OK, any pending configuration changes are lost and the SCM Configurati
application is closed. If you click on Cancel, the application remains open so that you may
the pending changes. 

Note If you select Refresh  during the configuration process, any configuration changes made in any co
figuration window will be lost unless they have been saved to the unit. 

Note You can keep multiple configuration windows open on-screen and move between them by clicking 
mouse on the border of the window in which you intend to operate. The main configuration window
mains on-screen throughout the configuration process. 

Note When you change a value or setting, the application displays the option name and the new value in 
text, rather than black. The option will remain white until the changes are stored to the unit or a temp
or discarded.
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Issue 1



SCM Configuration Redundant SCM Options Window

 SCMs 
ckup. 

r from 

CM 

en the 
Redundant SCM Options Window
This window is accessed via Navigate -->Redundant SCM Options  from the main 
window menu. This window (Table 4-3) allows you to set three SCM operating characteristics 
involved in the use of a backup SCM installed in the SpectraComm shelf. When there are two
installed, each must be configured by means of a DIP switch as either the Primary or the Ba
The options in this window are associated with conditions where the Backup SCM takes ove
the Primary SCM.

Note The Redundant Timeout  option is not available and appears grayed-out when there is only one S
installed in the shelf.

Note When using redundant SCMs, make sure that they are configured identically to minimize disruption wh
Backup takes over.

Table 4-3 Redundant SCM Option Selections

Redundant SCM Options Window Selections Description

SCM Type Displays Primary or Backup

Alive Trap Generation Displays how often the SCM transmits 
a trap that confirms its presence to the 
controller. 
Select: 0 (Disabled) or
5 to 60 minutes, in 5-minute intervals.

Redundant Timeout Specifies how long the Primary SCM is 
required to be inactive before the 
Backup SCM automatically takes over. 
When there is only one SCM installed 
in the shelf this option is grayed out. 

Operating Mode In a Primary SCM, this is a read-only 
display that reads Active or Sleep.

In a Backup SCM, you can select 
Active to put the Backup into operation 
and the Primary into Sleep mode. In 
this configuration, the two units will 
remain in these modes until a hardware 
reset is performed at the Primary SCM. 

OK Dismisses the window, similar to a pin 
pull. Edits are maintained but not 
saved.

Reset Undoes pending edits since last 
“File --> Save to Unit” operation.

Cancel Same as Reset, and dismisses the 
screen.
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Trap Options Window

This window is accessed via Navigate -->Trap Options  from the main window menu. The
Trap options window (Table 4-4) allows you to configure traps supported by the SCM. Traps a
used in SNMP to send unsolicited information to a network manager. The information usual
consists of events or alarms sent to the network manager for reports or special processing. Th
can store up to five Trap destinations. Each Trap destination includes the IP Address and UD
of the network manager and the Community Name. Table 4-5 describes the SCM-supported trap

Note The Trap Destination Table in the SCM must be filled out if a network manager is to receive Traps. 

Table 4-4 Trap Options Window

Selections Items Description

Trap Generation All Traps Enables or Disables the Trap facility.

Authentication Traps Masks or unmasks the Authentication Failure Trap.

Trap Destination Table Read-only list of IP addresses and their associated UDP ports and Community 
Names. Refer to procedures below.

Selected Entry Criteria IP address, UDP Port Filled in by the user or by selecting a trap destination 
from the table

Community Name Used to add a new Community Name.
Used to delete or replace a Community Name 
associated with an existing trap destination.

Command Buttons OK Dismisses the window, similar to a pin pull. Edits are 
maintained but not saved.

Reset Undoes pending edits since last 
File --> Save to Unit  operation.

Cancel Same as Reset, and dismisses the screen.
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Trap Definitions and Considerations

 Once the SCM is plugged into the shelf, Cold Start, Link UP, Link DOWN, Express Poll and A
traps may be sent to the network manager whenever units or interfaces change state. 
Refer to Table 4-5 for a description of all SCM-supported traps.

Note The WAN interface, the DBU WAN interface, and the WAN interface of the SCM CTRL port can change
(UP or DOWN) during normal operation. Note that the Ethernet interface is never in the DOWN state

Trap Procedures

Adding a Trap Definition

1. In the All Traps field, select Enable .

2. To send the Authentication Failure Trap at the appropriate time, select Enable  in the 
Authentication Traps field. To prevent it from being sent, select Disable .

3. In the Selected Entry Criteria section of the window, click in the IP Address field, then typ
the address of the intended destination.

4. Click in the UDP Port field, then type in the port number used by the SNMP manager. 

Note Use the default port number (162) unless the system administrator requires a different port.

5. Click in the Community Name field, then type in the Community Name associated with t
Trap destination.

6. Click on the Add button to complete the edits.

7. Click on OK to commit the new Trap definition to the configuration.

Table 4-5 SCM-supported Traps

Traps Description

Cold Start Trap Trap is sent when the Ethernet interface is UP.
Trap is sent when the SCM or other network element is powered up. 

Link UP Trap Trap is sent when an network interface (other than Ethernet) comes up.

Link DOWN Trap Trap is sent when a network interface (other than Ethernet) goes down.

Express Poll Trap Trap is sent when the state of a network element changes.
States are Inactive, Active, or Active with errors.

Alarm Trap Trap is sent when a network element detects a change in its alarm 
information. The Alarm Trap can be masked in the Node Table by either 
turning off the alarm scan to a network element or through the SCM 
which toggles all alarm traps (Trap Control)

Authentication Failure Trap sent when an SNMP command is received with an incorrect 
Community Name (can be masked by means of the Authentication 
Traps field)
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Editing a Trap Definition
1. In the Trap Definition Table, click on the Trap definition that you want to edit. The Trap 

information appears in the corresponding Selected Entry Criteria fields.

2. Make the desired edits in the Community Name field.

3. Click on the Replace  button.

4. Click on OK to commit the new Trap definition to the configuration.

Deleting a Trap Definition
1. In the Trap Definition Table, click on the Trap definition that you want to delete. 

2. Click on the Delete  button.

3. Click on OK to commit the new Trap definition to the configuration.
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SCM IP Routing Options Window

This window is accessed via Navigate -->SCM IP Routing Options  from the main 
window menu. This window (Table 4-6) allows you to configure IP routing options supported b
the SCM. In the IP group of MIB-II there is an IP Routing Table that contains an entry for each
known to the SCM. The main function of the table is to equate each out-going IP packet with a
that provides the physical interface port. The routing table can be built via SNMP if there is 
existing IP connection to one of the ports. The routing table is stored in volatile memory, an
lost if the SCM is repowered. Table 4-7 provides examples of valid subnet masks.

Table 4-6 SCM IP Routing Options Window

Selections Items Description

IP Destination Table Read-only list of IP destinations and their associated masks, interfaces, next 
hops and route types. (Refer to procedures below.)

Selected Entry Criteria Used to add, delete or replace an IP destination from the routing table.

Used to add, delete or replace a mask which is used to divide the IP addresses 
into network identifier and host identifier. (Refer to Table 4-7).

Interface Selects the routing interface type: 
GDC LAN Port, GDC WAN Port, LAN/WAN Port

Next Hop Direct indicates the IP address of the SCM.
Indirect indicates the IP address of the default gateway.

Route Type Direct indicates target device is on the same segment.
Indirect indicates target device is not on the same segment.

Command Buttons OK Dismisses the window, similar to a pin pull. Edits are maintained 
but not saved.

Reset Undoes pending edits since last File --> Save to Unit  
operation.

Cancel Same as Reset, and dismisses the screen.
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Note This mask is the filter used to establish the Routing Table. It must be set by an experienced network
administrator. 

Note The bits set to ‘1’ in the mask correspond to the network identifier. The entire network identifier portion
be contiguous and to the left of the host identifier portion. 

Table 4-7 Examples of Valid Masks and Subnet Masks

Subnet Masks Description

255.0.0.0 Standard Class A network mask

255.128.0.0 Class A network, 2 subnetworks

255.192.0.0 Class A network, 4 subnetworks

255.224.0.0 Class A network, 8 subnetworks

255.255.0.0 Standard Class B network mask

255.255.128.0 Class B network, 2 subnetworks

255.255.192.0 Class B network, 4 subnetworks

255.255.224.0 Class B network, 8 subnetworks

255.255.255.0 Standard Class C network mask

255.255.255.128 Class C network, 2 subnetworks

255.255.255.192 Class C network, 4 subnetworks

255.255.255.224 Class C network, 8 subnetworks

Subnet Mask IP Address Network Ident Host Ident

255.255.255.0 192.9.200.100 192.9.200.0 100

192.9.200.200 192.9.200.0 200

255.255.255.128 192.9.200.200 192.9.200.0 200

255.255.255.128 192.9.200.100 192.9.200.0 100

192.9.200.200 192.9.200.128 72

255.255.255.192 192.9.200.100 192.9.200.64 36

192.9.200.200 192.9.200.192 8
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SNMP Routing Procedures

Adding an IP Route
To add an IP Route:

1. Click in the Destination  field and enter the appropriate address.

2. Click in the Mask field and enter the mask.

3. Click on the Interface  field and select the interface type.

4. Click in the Next Hop  field and enter the address of the next hop.

5. Select the appropriate route type from the Route Type  field.

6. Click on the Add button.

7. Click on OK to commit the new IP routing definitions to the configuration.

Editing an IP Route
To edit an IP Route:

1. In the IP Destination Table select the item that you want to edit. The IP Routing informati
the selected item appears in the Selected Entry Criteria  fields.

2. Perform the desired changes.

3. Click on the Replace  button.

4. Click on OK to commit the new IP routing definitions to the configuration.

Deleting an IP Route
To delete an IP Route:

1. In the IP Destination Table select the item that you want to delete.

2. Click on the Delete  button.

3. Click on OK to commit the new IP routing definitions to the configuration.
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Maintenance Application
The Maintenance window is launched from a unit’s Front Panel Select menu or by selecting
SCM symbol on the shelf submap, then select Maintenance  from the Configuration menu. The
application window allows you to control the Alarm Scan function for the selected SCM. 

Note The application periodically polls the SCM while the Maintenance window is open. It should not be le
display unnecessarily. 

Table 4-8

Maintenance Application Window Selection Description

File Menu Exit dismisses the application.

Edit Menu Alarm Scan function: 
Select Enable or Disable

Alarm Scan Status display: ON or OFF.
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Chapter 5: Shelf Configuration

Shelf Configuration for TEAM 5000 Applications)
The Shelf Configuration application provides the specialized configurations required for the 
operation of TEAM 5000 applications. These configurations include the backplane highway 
timing parameters used to coordinate the Line Termination Units (LTU) and Data Set Emula
(DSE) units responsible for exchanging data over the data highway bus system. This system
of the SpectraComm shelf backplane. 

Shelf Configuration consists of the following functions:

• Shelf Timing

• Highway Allocation Status

• LTU Highway Configuration

• DSE Highway Configuration

• Slot Services Window

Exceptions

The TEAM Core Shelf Configuration is not used when the SCM is located in a UAS shelf with 
7000 series devices. Rather, the UAS 7000 devices use one of the following TEAM 7000 
applications:

• TEAM 7000 T1 Shelf Configuration application

• TEAM 7000 E1 Shelf Configuration applcation
058R720-V420 TEAM Core Operation Manual 5-1
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Shelf Main Configuration Window

The main Shelf Configuration window is launched by selecting a shelf icon from the Universe
then select Shelf Configuration  from the Configuration menu. When the main Shelf 
Configuration window opens, the application reads the current configuration data from the s

The main Shelf Configuration window menu bar provides a File and Navigate menu for config
the selected shelf. Use the Navigate  menu to select the individual configuration option window
for change. Use the File  menu for storage and retrieval of configuration settings. Table 5-1 
describes the Shelf Configuration display and menus. Configuration procedures follow the t

Table 5-1 Shelf Configuration Window Fields and Menus 

Fields Items Description

Display Name Read-only user-defined shelf name of the selected unit.
This field appears with the same designation on all other subordinate 
screens.

MIB Version Displays revision level of the MIB file that enabled SNMP control.

File Menu Refresh Causes all option settings to be read from the shelf. Any pending edits 
are lost.

Save to Shelf Causes all outstanding edits to be sent to the shelf.

Exit Terminates application with outstanding edits discarded first.

Navigate 
Menu

Shelf Timing Sets primary and fallback sources of the timing signals on the 
SpectraComm shelf backplane.

Highway Status Read-only display of individual timeslots that make up the four 
backplane data highways.

LTU Highway 
Configuration

Configures an LTU to one of the four backplane data highways and 
makes DS0 assignments for various functions or conditions.

DSE Highway 
Configuration

Configures a DSE to one of the four backplane data highways and 
makes timeslot assignments for exchanging data with its LSU.

Service Status Displays the current operating status of all devices in the shelf or 
shelves that are under TEAM control. Also commands a change in 
status (UP or DOWN) for each of up to 32 slots.

All Screens Displays all subordinate windows of the Shelf Configuration 
application.

Messages

Menu Bar

Read-only
Fields

Window
Manager Bar
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Shelf Configuration Procedures

1. Access the Shelf Configuration window from the Universe map. The application reads th
current configuration from the SCM each time you open this window. 

2. Click on the Navigate  button to display a menu of Shelf Configuration windows.

3. Select the first one in which you intend to make changes. In each configuration window,
on the desired input fields to open a list of available values for each option, then click on
desired value. 

4. You can discard changes made in a configuration window and return all its fields to their s
values in two ways:

• Click on the Reset  button to discard changes while keeping the window open

• Click on the Cancel  button to discard changes and close the window. 

5. Close a configuration window without losing changes by clicking on either the OK button or 
the push-pin glyph in the upper left corner of the window.

6. Continue to select other configuration windows to make additional changes. Refer to the
following sections of this chapter for descriptions of each shelf configuration window me
and its selectable options.

7. When you have accessed all the configuration windows for changes, use the main Shel
Configuration window File menu to save all changes. Select Save to Shelf  to send the 
changes to the shelf as the new current configuration. This activates the changes instan
the shelf.

8. If you attempt to Exit from Shelf Configuration without having saved configuration chang
pop-up window appears with the message: 

APPLICATION HAS PENDING EDITS. 

The following screens have pending edits: 

Discard Edits and Exit Application? 

If you click on OK, any pending configuration changes are lost and the Shelf Configurati
application is closed. If you click on Cancel, the application remains open so that you may
the pending changes. 

Note If you select Refresh  during the configuration process, any shelf configuration changes made in a
configuration window will be lost unless they have been saved to the shelf. 

Note You can keep multiple configuration windows open on-screen and move between them by clicking 
mouse on the border of the window in which you intend to operate. The main configuration window
mains on-screen throughout the configuration process. 

Note When you change a value or setting, the application displays the option name and the new value in 
text, rather than black. The option will remain white until the changes are stored to the shelf or a temp
or discarded.
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Shelf Timing Window

This window is accessed via Navigate -->Shelf Timing  from the main window menu. The
SC 5000 system requires the timing signals in order for the DSEs and the LTU to maintain t
proper timing relationship as they exchange data over the backplane data highways. The S
Timing configuration window (Table 5-2) allows the user to specify and control primary and 
fallback sources of the timing signals on the SpectraComm shelf backplane.The read-only Name 
field identifies the shelf.

Table 5-2 Shelf Timing Window Selections

Selection Field Description

Primary Clock Provider Clock Provider Selects the slot number of the device responsible for providing clock 
signals on the backplane data highway.

Timing Source Selects the source of the Primary Clock Provider’s clock signal:
     None, Network, Internal, Station, Cascade, or External DTE Clock.

External Timing 
Source

When External DTE Clock is activated at the Timing Source field, this 
field selects the DSE that passes external timing from its DTE along to 
the LTU. 

Fallback Clock Provider Clock Provider Selects the slot number of the device responsible for providing clock 
signals on the backplane data highway if Primary Clock Provider fails. 

Timing Source Selects the source of the Fallback Clock Provider’s clock signal. 
     None, Network, Internal, Station, or Cascade

Primary Clock Control Auto Revert to 
Primary Provider

Automatically returns to primary Clock Provider when it becomes 
available. Select: Enable or Disable

Current Clock 
Provider

Read-only display of the clock provider currently in use:
     Primary, Fallback or None

Revert to Primary 
Provider

Commands a switch from the Fallback Clock Provider to the Primary 
Clock Provider.

Command Button OK Dismisses the window. Edits are maintained but not saved. Changes do 
not go into effect until you perform Save To Shelf  in the main 
Shelf Configuration window.
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Shelf Timing Considerations

• The External Timing Source  option will not be available and will appear grayed-ou
unless the selected timing source is External DTE Clock. 

• When the External Timing Source option is selected, you must also enable the 
Auto Revert to Primary Provider  option.

• The pulldown lists for Clock Provider and External Timing will only display the 
slots and devices that are able to provide the required clock signal.

• When Auto Revert to Primary Provider is enabled, the application continues t
check the status of the Primary Clock Provider while the shelf runs on Fallback Clock. T
application automatically returns to Primary Clock Provider when it becomes available. 

• When Auto Revert to Primary Provider is disabled, the shelf runs with Fallback
Clock until operator manually returns the shelf to Primary Clock Provider.
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Highway Allocation Status Window
This window is accessed via Navigate -->Highway Status  from the main window menu. 
This window (Table 5-3) is a read-only display of the individual time slots that make up the fo
backplane data highways. Each backplane time slot is the equivalent of a DS0 at the LTU ne
interface. The read-only Name field identifies the SCM responsible for the shelf. 

Note Yellow or orange status indicators display the slot number and the line number (SS:L). The line numb
always 1 for a DSE that only supports a single DTE. For DSEs which support two DTEs (such as the SC
each data channel constitutes a separate line and requires a separate time slot. 

Note The Highway Allocation window is also displayed when you open the LTU or DSE Highway Configur
applications, dynamically updating itself as changes are made in those configuration windows. Pend
(unsaved) configuration changes appear white until a Save To Shelf  is performed.

Table 5-3 Highway Allocation Window

Fields Items Description

Highway Labels Highways 1-4 Displays the highway number and the device identification label and its 
slot number.

Timeslots 1 - 32 Numbered fields corresponding to the timeslots on each data highway.
Slots 1 through 24 to support the SC 5001 LTU’s T1 operation.
Up to 32 time slots to support the SC 5002 LTU’s E1 operation.

Allocation 
Status
(Legend)

Yellow (SS:L) A time slot and a line number are assigned to a DSE for a private 
(dedicated) line application.

Orange (SS:L) A time slot and a line number are assigned to a DSE for a switched line 
or restoral application.

Green An unassigned time slot.

Tan A time slot that is unavailable for assignment to any DSE.
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LTU Highway Configuration Window 
This window is accessed via Navigate -->LTU Highway  from the main window menu. This
window (Table 5-4) allows you to associate an LTU with one of four backplane data highway
also configures the relationships between time slots on the data highway and the DS0s that c
the T1or E1 line to which the LTU is connected. The read-only Name field identifies the shelf.

Table 5-4 LTU Highway Configuration Window

Selections Items Description

Global Selection 
Buttons

Global commands which set all of the DS0s to: 
All on Highway, All on Cascade or All Not Present.

Selected LTU Selects the LTU to be configured from a pulldown list of slot numbers/device types.
Slot numbers 1 - 32
Device types: LTU 5001 or LTU 5002 

Selected LTU DS0 
Assignment

Operating Mode Selects the LTU operating modes:
In Concentrator mode, the LTU interfaces DS0s to the selected data highway or 
cascade port (according to the checked boxes) 
In CSU mode, the LTU interfaces all DS0s to its cascade port

Data Highway 
Selection

Selects the data highway to which the LTU interfaces DS0s. 

Check Boxes DS0s 1 - 32 Click a check box to assign the associated DS0 to the highway or cascade, or to 
assign the DS0 as Busy Out or Not present.

Command Button OK Dismisses the window, similar to a pin pull. Edits are maintained but not saved. 
Changes do not go into effect until you perform Save To Shelf  command.
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 LTU Highway Configuration Procedures

1. Click on the Selected LTU  field and select the LTU that you intend to work with. 

2. Click on the Operating Mode  field and select the mode in which the LTU is to function. 
you select CSU all DS0s are set to Cascade Port; no further configuration is then neces
If you select Concentrator, continue with the remaining steps of the procedure. 

3. Click on Data Highway Selection  and select the backplane data highway the LTU is
use for exchanging data with DSEs. 

4. Click on one of the global selection buttons at the top of the window – All on Highway, Al
Cascade, or All Not Present, selecting the category where the greatest number of DS0s 
in the completed configuration. All DS0s will be checkboxed accordingly. 

5. Change individual DS0 settings in the checkboxes to achieve your intended configuratio

6. Repeat steps 1-5 for each LTU to be configured. The application retains the pending ch
for the LTU(s) you have already configured. When you click on the Data Highway Select
button the selections for highways that are already assigned to LTUs are grayed out. 

7. When all edits are made, dismiss the window while preserving the pending changes by 
clicking on the OK button. If desired, the window can be left open while you use other 
applications.

8. Put the configuration into effect by using the Shelf Configuration window File menu selec
Save to Shelf . 

Note When CSU operating mode is selected, the Data Highway Selection field is grayed-out and all DS0s 
to Cascade Port in the checkboxes.

Note In the case of an SC 5001 LTU, only DS0s 1 - 24 are valid available for assignment.
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DSE Highway Configuration Window 
This window is accessed via Navigate -->DSE Highway  from the main window menu. This
window (Table 5-5) enables you to specify which time slots of a selected highway the DSE will
to exchange data with its LTU. Time slots are grouped by function: Private Line or Switched
Network/Restoral. Procedures for this application follow the table. The read-only Name field 
identifies the shelf.

Note For those products that do not support simultaneous use of their private and switched lines, selecting
checkbox in one category will render the other category anavailable. Checkboxes will appear grayed

Note In the Selected DSE pulldown list, line number is always 1 for DSEs that only support a single DTE. For
which support two DTEs (such as the SC 5034) the list will provide individual line selections for that D

Table 5-5 DSE Highway Configuration Window

Selections Fields Description

Selected DSE Selects the DSE to be configured from a pulldown list of slot numbers/line numbers/device types.

Private Line Time 
Slot Assignment

or
Switched Network/
Restoral Time Slot 

Assignment

Highway 1-4 Selects the data highway to which the DSE interfaces DS0s. 

Slots 1-32 Numbered fields corresponding to the timeslots on each data highway.
Slots 1 through 24 to support the SC 5001 LTU’s T1 operation.
Up to 32 time slots to support the SC 5002 LTU’s E1 operation.

DS0s 1 - 32 Click a check box to give the DS0 the selected time slot assignment:
Private Line or Switched Network/Restoral

Command Button OK Dismisses the window, similar to a pin pull. Edits are maintained but not saved. 
Changes do not go into effect until you perform Save To Shelf  command.
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Special Considerations

• DSEs that employ constant, dedicated line connections to their remotes, such as SC 55
SC 5553 DSEs, require private line time slots. 

• DSEs that perform dial-up modem functions, such as SC 5034 DSEs, require switched ne
time slots. 

• A DSE that normally operates on a dedicated connection and has restoral capability for 
case of trouble with that connection requires time slot assignments for both functions. 

• The application enforces limits based on the DSE device type. An SC 5520 DSE, for exa
can be assigned only one time slot, since it employs a single DS0 on the line connected
LTU network interface. A DSE that performs fractional T1 or fractional E1 functions can 
assigned as many time slots as are required to support its fractional T1/E1 data rate. Wh
assign multiple time slots for fractional T1/E1, they must be sequential, just as the DS0s 
line must be sequential. 

DSE Highway Configuration Procedures

1. Click on the Selected DSE  field and select the DSE that you intend to work with. 

Note If you are configuring an SC 5034 DSE, remember that time slots for Line 1 and Line 2 need to be con
separately. 

2. Click on the Highway field for the desired time slot category (Private Line or Switched 
Network/Restoral). Select the backplane data highway the DSE is to use for exchanging
with its LTU. 

3. Click on the check box(es) for the time slot(s) you are assigning to the DSE. 

4. If you have more than one LTU to configure you can return to Step 1, select the next DSE
repeat the procedure. The application retains the pending changes for the DSE(s) you h
already configured, and grays out the time slots you have already assigned. 

5. When all edits are made, dismiss the window while preserving the pending changes by 
clicking on the OK button. If desired, the window can be left open while you use other 
applications.

6. Put the configuration into effect by using the Shelf Configuration window File menu selec
Save to Shelf . 

Note Private Line Time Slot assignments and Switched Network/Restoral Time Slot assignments are mutu
exclusive. When a DS0 is selected in one area, the other area will be unavailable for that highway an
appear grayed-out.

Note In the case of an SC 5001 LTU, only DS0s 1 - 24 are valid and available for assignment.
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Slot Service States

This window is accessed via Navigate -->Services States  from the main window menu. 
Users can view the current operating status of all devices in the shelf (or pair of shelves) tha
subject to TEAM software control by means of color-coded status indicators (Up or Down) fo
to 32 card slots. For card slots that contain multi-line devices, such as SC 5034 DSEs, it disp
separate indicator for each line. The read-only Name field identifies the shelf. Table 5-6 describes 
the selections at this window, with procedures following the table. 

Note Green or tan status indicators identifies the applicable line number. The line number is always 1 for D
that only support a single DTE. For DSEs which support two DTEs (such as the SC 5034) the indicato
be numbered appropriately. Status for each line in a multi-line device can set separately Up or Down

Note The Shelf Configuration application enables Up/Down checkboxes for as many lines as the device su

Table 5-6 Slot Services Configuration Window

Selections Fields Description

Slot:Line Operating 
Status

Slots 1-32 An Operating Status display consists of up to 32 numbered fields which 
correspond to card slots of a pair of SpectraComm shelves ribbon 
cabled together in a single system. For a one-shelf system, only fields 
1-16 are valid. 

Status Indicator
(Legend)

Green Indicates the line status of the device in that slot is currently UP.

Tan Indicates the line status of the device in that slot is currently DOWN..

Desired Status Select Card Slot Selects individual card slots from a pulldown list in order to make 
operating status changes. For multi-line devices, status can be 
changed on a line by line basis, for up to 4 lines. 

Command Button OK Dismisses the window. Edits are maintained but not saved. Changes do 
not go into effect until you perform Save To Shelf  command.
058R720-V420 TEAM Core Operation Manual 5-11
Issue 1



Shelf Configuration Slot Service States

nd 

want 

tion 

tion, 
Slot Service Procedure

1. Click on the Selected Card Slot  field to select the card slot and device that you inte
to work with. 

2. Under the appropriate line identifier, click on the check box for the operating status you 
assigned to that device and line (Up or Down) 

3. Repeat this process to change the status of as many devices as is desired. The applica
retains the pending changes for the previous changes. 

4. When all edits are made, dismiss the window while preserving the pending changes by 
clicking on the OK button. If desired, the window can be left open while you use other 
applications.

5. Put the configuration into effect by using the Shelf Configuration window File menu selec
Save to Shelf . 
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Chapter 6: TEAM Core Utilities

Overview

The TEAM core software application includes utility functions that are launched from higher o
maps and do not fit into the same categories as the operations performed from the Shelf map
utility applications are described in this chapter:

• Firmware Download for All TEAM applications
(launched from the Universe map with a shelf icon selected).

• Group Configuration for TEAM SC553 application only
(launched from the Root map with the TEAM Universe icon selected)

• Line Statistics Collector for TEAM SC553 application only
(launched from the Root map with the TEAM Universe icon selected)

Firmware Download Application

SpectraComm Firmware Download application is launched only from the Configuration men
an OVW submap after a shelf has been selected. The application allows you to download n
firmware files into the devices controlled by the SCM, including devices in the SpectraComm
as well as some of the remotes linked to those devices. 

Standby Firmware Support

Some SCM-compatible devices can store two revisions of operating firmware, designated a
Active firmware revision and the Standby firmware revision. The Active revision is the firmw
currently operating in the device. The Standby revision is alternate firmware to which the de
can be commanded to switch over. The functionality for switching between firmware version
part of the Firmware Download application. 

In devices that support standby firmware, new firmware is initially the standby revision when
loaded. When the new firmware becomes the active revision, the previous firmware is retain
the standby revision. This arrangement permits restoration of the earlier revision if there are
problems with new firmware. 

Note IMPORTANT: Before performing any firmware download or switchover procedure, be sure to consult
individual TEAM Operation Manual and any accompanying Release Notes for the target device.
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Main Firmware Download Window

Firmware Download Application begins with the main Firmware Download window, shown be
The window’s File menu provides the Refresh  command and an Exit  command. The Navigate
menu is used to access the subordinate windows: Task Queue and Download History. The 
window is described in Table 6-1 and Table 6-1. Procedures follow the table.

Note The time required to complete a download varies greatly depending on Target Equipment type. 
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Note If the target device does not support standby firmware, the Standby FW column in the Equipment list
display 00.00.00. If the target device does not support standby firmware, newly downloaded  firmwar
automatically active firmware. For such devices, the buttons for Switch Active Firmware  and 
Download & Switch Active Firmware  will not be selectable and will appear grayed-out. 

Note If the target device does not employ boot code, the Select Boot Code button will not be selectable an
appear grayed-out.

Note IMPORTANT: If you intend to download firmware to master devices and their remotes, first select ea
remote separately and then download its firmware manually. When all remotes have been downloade
you can group the master devices and download firmware to that group. Do not use the Select All  
button on remotes. Doing so will cause the remote’s standby firmware to be lost. 

Table 6-1 Firmware Download Window Selections

Field Item Description

Equipment 
Selection 
Criteria

Target Equipment Select A pull-down list for specifying the type of equipment targeted 
to receive the firmware download. 

Target Equipment List A selectable list which details the individual units targeted to 
receive the firmware download:

SS:LL:DD  identifies the device by its Slot:Line:Drop address.
Active FW identifies the revision level of the firmware currently 
operating in the selected unit.
Standby FW identifies the revision level of thee alternate 
firmware.
Boot Rev identifies the hardware revision of the SC 553 
printed circuit board. (Not displayed for other device types.)

Global Select Buttons Select All and Deselect All buttons which globally control the 
selection boxes in the Unit List.

Task Type 
Selection

Download Firmware Downloads the specified firmware to be immediately active.
If the target device supports standby firmware, specified 
firmware is downloaded and stored as the standby version.

Switch Active Firmware Activates the standby firmware in the target device and shifts 
the previous active firmware to standby status.

Download & Switch 
Active Firmware

Downloads the specified firmware, then activates it and shifts 
the previous active firmware to standby status.

Download Order All At Once Executes a simultaneous download to all selected devices.

Sequential Executes downloads to the selected devices one at a time. 

Firmware 
Selection 
Criteria

Boot Code Data Read-only displays of Boot Code and Application Code data:
Filename of the firmware to be loaded
Equipment Type intended for download
Firmware Revision Level

Application Code Data

Select Boot Code Button Opens a Filter window for specifying the intended firmware 
filename and path to be downloaded.Select Appl Code Button 

Execute Buttons Execute Now Button The selected task is put into a queue to be performed as soon 
as there is not another task running

Execute Later Button Opens the Task Queue window for scheduling the selected 
task at a future time.
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Firmware Download History Screen

The Firmware Download History window is accessed from the Navigate menu of the main 
Firmware Download window. This window is a read-only display of detailed status informatio
past download operations. Figure 6-1 illustrates a typical download history. Use the Close  button 
at the bottom of the window to dismiss the Download History display. 

Figure 6-1 Download History Screen
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Firmware Download / Switchover Procedures

Firmware Download application allows you to perform the following Firmware procedures:

• Setup

• Immediate Firmware Download

• Immediate Firmware Switchover

• Scheduled Download

• Scheduled Firmware Switchover

Note Download Setup is used to prepare for both downloading as well as switchovers. 

Download Setup Procedure

Setup prepares for either immediate or scheduled download of firmware. It also allows the u
perform a scheduled or immediate switchover from active to standby firmware on those dev
with standby capability. A switchover can be performed without a download of new Firmwar

1. Make sure the firmware to be downloaded is resident on the workstation running TEAM.

2. In the TEAM Universe map, select the shelf that contains the SCM you need to use.

3. Select Firmware Download...  from the Configuration menu. The SpectraComm 
Firmware Download window appears. 

4. Click on Target Equipment  and select the desired device type. A list will appear of al
units of the selected device type that are controlled by the SCM and identifying data for 
one. For the SC 553 DSU, an additional column for Boot Rev data will display.

Slot field displays 1 – 16 when the SCM controls a single shelf.
Slot field displays 1 – 32 when the SCM controls a pair of shelves.
Line 1is displayed for most devices.
Line 1 and Line 2 is displayed for the Dual V.34 modem, representing Device A and Devi
Drop 0 is displayed for the local device that occupies the shelf with the SCM.
Drop 1 and higher are displayed for remote devices. 

5. In the Target Equipment list, select the device(s) to be setup for download or switchover

Note Click on a device in the list to select and deselect it individually. Use the two select buttons under the
globally Select All  or Deselect All . 

6. Select the task type (Download Firmware , Switch Active Firmware , or 
Download & Switch Active Firmware .) 

Note For equipment that does not support standby firmware, Download Firmware  is the only task type. 

7. If more than one device has been selected for download, select the download order as 
Sequential or All at Once . 

Note If any of the devices being downloaded are remotes, you must select the Sequential  download order. 
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8. For downloads, click on a Select (Application or Boot) Code...  button. A 
Filter window appears for specifying the filename and path for the new code files. 

Note For equipment that runs boot code, you can download boot code and application code in a single ope

9. Proceed to the Immediate Download procedure to execute the task now. 
Proceed to the Scheduled Download to execute the task at a later time. 

Immediate Download Procedure

1. After completing the Download Setup procedure, click on the Execute Now  button. 
A confirmation box appears. 

2. Click Yes in the confirmation box to proceed. The application adds the task to its Task Qu
If there is no other task already executing, the download begins immediately. 

3. Click No in the confirmation box to resume changes to the Download Setup, or to exit th
Firmware Download application. 

4. You can view the Task Queue window by selecting it from the Navigate menu. If there ar
other tasks already in the queue, a newly added Execute Now task can result in 
considerable delays.

Scheduled Download Procedure

1. Click on the Execute Later button in the main Download window. A confirmation box 
appears. 

2. Click No in the confirmation box to return to the Setup window, or to exit the Firmware 
Download application. 
Click Yes in the confirmation box to proceed. The application adds the task to its Task Q
and displays it highlighted with an initial status of To be scheduled . 

3. To queue the task for execution at the earliest opportunity, select Queued from the pulldown 
list. This is the same as using the Execute Now  button. 

To delay the execution of the task, select Scheduled  from the pulldown list. Now, make 
selections at the month , day , hour , minutes , and AM/PM fields to define when the task 
will be queued for an immediate download. 

Note If you specify a date that has already passed in the current year, the application assumes that the da
in the coming year. 

Note Selections made at the Scheduled/Queued  field will not go into effect until you click on the Change 
Task Status  button (step # 4, below).

4. Click on the Change Task Status  button to put the new settings into effect and updat
the Task Queue display. To change scheduling, select the task and then repeat steps 3 

5. Use the Close  button to dismisses the Task Queue window. 
6-6 TEAM Core Operation Manual 058R720-V420
Issue 1



TEAM Core Utilities Firmware Download Application

ad 

sks. 
Firmware Download Task Queue Window
The Firmware Download Task Queue window is accessed from the main Firmware Downlo
window’s Navigate menu. The Task Queue window displays status information on current, 
pending, and past download or switchover operations. It also allows the user to schedule ta

Table 6-2 Firmware Download Task Queue Window

Items Fields Description

Task Queue Task # Identifies the queued task by a task number assigned by the 
application

Task Type Identifies the queued task by the equipment type and by the task 
type as selected by the user during Download SetupTarget Equipment

Task Status Displays the user-defined status of the current, pending and past 
download or switchover tasks. 

Selected Task 
Criteria

Task Detail Read-only display which identifies in detail the highlighted task as 
listed in the Queue along with information describing the code to 
be downloaded.

Group Members Scrollable list that identifies all the individual target units for the 
task according to their slot:line:drop addresses.
058R720-V420 TEAM Core Operation Manual 6-7
Issue 1



TEAM Core Utilities Firmware Download Application

d 
Note When the status of the selected task is Queued, the Selected Task Criteria functions are not available an
will appear grayed-out.

Task Status Definitions
Complete-No Errors: Task accomplished successfully.

Complete-With Errors: Task completed, but errors are detected in the new firmware.

In Progress: Task presently being performed.

Queued: Task initiated via the Execute Now command and waiting to
execute as soon as tasks queued ahead of it are complete.

Scheduled (date/time) Task initiated via the Execute Later command and scheduled 
for future execution via the Task Execution Time fields.

To be Scheduled: Task initiated via the Execute Later command and not yet
scheduled via the Task Execution Time fields.

Task Execution 
Time

Scheduled/Queued Selects whether the highlighted task will be scheduled for 
execution or returned to the queue to be scheduled at a future 
time.

Month, Day, Hour, 
Minutes, AM/PM 
fields

Selects values from these fields in order to define when the task 
will be queued for an immediate download or switchover. 

Command 
buttons

Delete Task Deletes the highlighted task from the Task Queue display.

Change Task Status Click to put the pending task settings into effect and to update the 
Task Queue display. 

Table 6-2 Firmware Download Task Queue Window

Items Fields Description
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Group Configuration Application (for SC 553 DSUs only)
The Group Configuration application is launched from the Configuration menu of the Root m
Group Configuration allows the user to: 

• set up a group of SC 553 units to be configured

• select the template to be used for configuring the SC553 units

• schedule when the configuration procedure is to begin

Group Guidelines

By grouping SC553 DSUs, the user can then apply a configuration template so that all units 
group will receive the same configuration. The desired configuration must be first set up usin
TEAM SC553 Configuration application and stored as a template. Through the use of the st
template, the configuration can be loaded into multiple SC553 units. 

• All units in the group must be the same type of device (all SC 553 DSUs). 

• The TEAM SC553 application package must be installed and available at the TEAM Co
workstation.

• Templates must be created in advance by the TEAM SC553 Configuration application for
group of SC553 units to be configured.

• Grouped units can be installed in multiple shelves and do not have to be located at the sam

• By functioning from the Root map at the top of the map hierarchy, the Group Configurat
application can access all compatible units in the TEAM universe. 

Note IMPORTANT: Once launched, the Group Configuration application should be kept running in order to r
its database of group assignments. When not in use, the Group Configuration window can be reduce
on-screen icon.

Exiting the Group Configuration application will clear group assignments and clears accumulated sta
data. The next time the application is launched, new groups can be created. 

Using Templates

Templates store a particular configuration for the unit options. Users can store as many tem
as needed. Use the TEAM SC 553 Configuration application and save the configuration as 
template on the workstation that runs the application, as described in the procedure below. 
detailed instructions, consult the TEAM SC553 Operation Manual and associated Release Note

1. Access the TEAM SC553’s main Configuration window. The application reads the curre
configuration from the selected unit when you open the main window. You can base a ne
configuration template on either the selected unit’s current configuration or a previously s
template. 

• To create a template by editing an existing template, select Load Template  from the 
File menu and select a template from the resulting list. 

• To create a template by editing the unit’s current configuration, click on Navigate  to 
display the application’s menu of configuration windows, and select the one in which
intend to make changes. 

2. Make changes as needed in the configuration window, then select and make changes in
additional configuration windows as needed.
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3. When all configuration windows have been changed, select Save to Template  from the 
main Configuration window File menu. A list of existing templates appears with a field fo
entering a new template name. 

4. Select an existing template to be overwritten with the new configuration, or enter a new 
to create a new template. Once a template is stored in the workstation, it is available for
with the Group Configuration application. 

Group Configuration Windows 

• Main Group Configuration Window
Provides status display of existing groups and is the access point to the application’s oth
windows. 

• Create Group Window
Permits naming a group, selecting its members, and assigning a Task Control status. Ass
Idle status completes the creation procedure. Assigning Schedule or Start Now status re
template selection to complete the creation procedure. 

• View/Modify Group Window
Permits changing the membership of a group, and changing its Task Control status. Use
window to schedule or start groups that were created with Task Control status Idle, or g
that have been used before. Template selection is required each time a group’s status is c
to Schedule or Start Now. 

Operating instructions for the Create Group and View/Modify Group windows are the same e
for the Group Name assignment function. There are additional windows for changing group n
and for the display of status information. 

Note The application transmits configuration to multiple units at a time (exact number determined by data t
and other factors). Each iteration of the Group Configuration process requires several minutes to com
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Main Group Configuration Window

When you launch the Group Configuration application it displays its main window, shown be
This window allows the user to create, modify and delete groups. The user can then configu
grouped devices immediately or schedule the process at a later time. Table 6-3 describes the menus
and selections. Procedures and descriptions of subordinate screens follow the table.

Table 6-3 Main Group Configuration Window

Selection Description

Create Group Button Advances to the Create Groups window.

Current Groups Field Displays a selectable list of each existing group by name, status and the 
device type.

View/Modify Button Opens a window for viewing and changing a selected group by adding/
removing devices, changing the task control status or the device type.

Modify Name Button Opens a window for changing the name of a selected group.

Delete Button Removes the selected group.

File Menu Select Exit to dismiss the window. 

Navigate Menu Select System Inventory to display a list of every accessible unit that could 
be subject to Group Configuration

Select Group Member to display the status of devices.
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Create Groups Window

At the main Group Configuration window, click the Create Group...  button to advance to the
Create Groups window. Use this window to select the individual units to be configured as a g
The Current Groups panel contains a window that lists groups that have been created and t
current status. One group at a time can be selected by clicking on its selection box. 

Figure 6-2 Create Group Window

Create Group Procedure

1. In the Root map, click on the TEAM universe icon to highlight it. 

2. At the Configuration menu, select Group Configuration . The main Group 
Configuration window appears.

3. Click on Create Group...  The Create Group window appears. 

4. Place the cursor in the Group Name field and type an identifying name for the new grou
devices. The name can be up to 24 alphanumeric characters and may include spaces a
underline character ( _ ). 

5. Click on Equipment Type and then select the type of device to be configured. 

6. The Shelves column now displays entries for all shelves in the system that contain at lea
unit of the selected type with a selection box for each shelf. 
6-12 TEAM Core Operation Manual 058R720-V420
Issue 1



TEAM Core Utilities Group Configuration Application (for SC 553 DSUs only)

igure. 
ype in 

 by 

t a 

 in 
iew/

 

play. 
te. 

lists.
7. Click on the selection box for each shelf that contains at least one unit you intend to conf
As each shelf is selected, the Cards column displays all units of the chosen Equipment T
the selected shelves. The individual units also have selection boxes

8. Click on unit selection boxes in the Cards column to select/deselect individual units for 
inclusion in the configuration group. 

9. When all desired units have been selected, choose one of the three Task Control states
clicking its diamond selection field: 

• Select Start Now  to initiate the group configuration process immediately. 
(Proceed to Step 11.) 

• Select Schedule  for the system to initiate the configuration process automatically a
time less likely to interfere with system operation (such as late at night). 
(Proceed to Step 10.)

• Select Idle  if you are creating the group for use at a future time. 
Proceed to Step 10 to set the time of day the process will eventually initiate.
Or proceed to Step 11.

10. In the Configuration Start Time  field, select the time at which configuration will 
initiate. Select AM or PM in 15-minute increments over the next 24 hours. 

11. Click on the Apply  button. 

• Groups created under Idle  task control are now added to the Current Groups display
the main window. The group creation process is completed at this point. Use the V
Modify function to initiate configuration of the group at later time. 

• For Groups created under Schedule  or Start Now  task control, the Select Template
window appears, as shown below: 

12.  At the Filter  field, specify the intended template’s directory location and file name. 

13. Click on the OK button. The newly created group is now added to the Current Groups dis
For Groups created under Start Now , the configuration process begins in about one minu

14. Click on the Close button to dismiss the Create Group window. 

Note For convenience, use the Select All and Deselect All buttons located under the Shelves and Cards 
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Modify Group Procedure

The View/Modify Group window allows you to change the contents of a group, schedule gro
configuration or start configuration of a group previously set as Idle when it was created. Yo
also use this window to send a new configuration to a group that was configured previously

Figure 6-3 View/Modify Group Window

1. At the main Group Configuration window, click on the selection box next to a group in th
Current Groups display.

2. Click on the View/Modify...  button to display the View/Modify Group window. 

3. To change the composition of the group, select or deselect shelves and individual units 
clicking on their selection boxes. Use the Select All  and Deselect All  buttons below 
the Shelves and Cards lists for convenience. To perform Task Control without altering th
group, go to Step 4. 

Note Every shelf in the system that contains at least one unit of the selected type will appear in the displa
gardless of whether any units are part of the current group. A shelf will appear grayed-out and canno
selected if all the units of the selected type are assigned to other groups. 

Note When you first select a shelf, all its units of the appropriate Equipment Type appear in the Cards list,
all of those units that aren’t already assigned to another group are selected. All Units that are assig
to other groups will appear grayed out and cannot be selected. 
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4. Select one of three Task Control states: 

• Select Start Now  to initiate the group configuration process immediately. 
(Proceed to Step 5.) 

• Select Schedule  for the system to initiate the configuration process automatically a
time less likely to interfere with system operation (such as late at night). 
(Proceed to Step 6.)

• Select Idle  if you are creating the group for use at a future time. 
Proceed to Step 5 to set the time of day the process will eventually initiate.
Or proceed to Step 6.

5. In the Configuration Start Time  field, select the time at which configuration will 
initiate. Select AM or PM in 15-minute increments over the next 24 hours. 

6. Click on the Apply  button. 

• Groups created under Idle  task control are now added to the Current Groups display
the main window. The group creation process is completed at this point. Use the V
Modify function to initiate configuration of the group at later time. 

• For Groups created under Schedule  or Start Now  task control, the Select Template
window appears.

7.  At the Filter  field, specify the intended template’s directory location and file name. 

8. Click on the OK button. The newly created group is now added to the Current Groups dis
For Groups created under Start Now , the configuration process begins in about one minu

9. Click on the Close button to dismiss the View/Modify window. 
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Modify Name Procedure
The Modify Name window enables you to change the name of a previously created group. 

Figure 6-4 Modify Name Window

1. At the main Group Configuration window click on the selection box next to a group in the
Current Groups display, then click on the Modify Name... button. The Modify Name 
window appears with an input field containing the current name of the group, and a read
display of the group’s current status, the selected template (if any) and the equipment ty

2. Position the cursor in the Group Name  field and replace or edit the name. It can be up to 2
alphanumeric characters; spaces and the underline character ( _ ) are permitted. 

3. Click on the Apply  button. The new group name replaces the former name in the main 
window Current Groups display. 

4. Click the Close  button to dismiss the Modify Name window. 
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The System Inventory window is accessed through the main Group Configuration Navigate m
This read-only window lists every accessible unit that could be subject to Group Configurati
Units already included in groups are identified by their Group Names. Use the Close  button to 
dismiss the window. 

Figure 6-5 System Inventory Window
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Group Member Status 

The Group Member Status window is accessed through the main Configuration Navigate m
Information is displayed in this window only after the Configuration Start Time for the group.
information will appear here concerning groups that have been created but not yet used. 

Figure 6-6 System Inventory Window

Status Line Descriptions

The display is arranged by groups, each group containing a group status line and individual
for each card in the group. A Group status line includes the group name, latest status, and t
latest status. A Card status line includes the group name, shelf and slot identification, latest 
and time of latest status. 

Table 6-4 Group and Card Status Descriptions

Conditions Typical Line Descriptions

Group Status Conditions Configuration Process Started.

Configuration Process Complete.

Configuration Process Cancelled. The process was cancelled via the View/
Modify window task control function.

Configuration Time Out. The product-specific configuration application is not 
responding. Cards in the group have retained their previous configuration.

Card Status Conditions In Progress. The selected card is being configured.

Completed. The card configuration is complete.

SNMP Error. There is a problem communicating with the card. Card’s current 
state is unknown.

Incompatible. The selected template is incompatible with the card. The card 
retains its previous configuration. 

Lost Request. An application error has occurred. Card’s current state is 
unknown.

Appl Time Out. Hardware unit is not responding to product-specific application. 
Unit retains its previous configuration.
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Line Statistics Collector (for SC 553 DSUs only)
The Line Statistics Collector application can be launched only from the Performance menu 
root map with the TEAM Universe icon highlighted. From this level of the map hierarchy, the 
Statistics Collector can be configured to retrieve data from any and all SC 533 unit in the TE
universe. 

Theory of Operation

The TEAM-controlled SC553 DSUs collect statistical information on their operations and reta
to 24 hours worth of information in seven categories: 

• Errored Seconds (ES)

• Bursty Errored Seconds (BES)

• Severely Errored Seconds (SES)

• Unavailable Seconds (UAS)

• Cyclic Redundancy Checksum errors (CRC)

• Loss of Frame Counts (LFC)

• Controlled Slip Seconds (CSS)

Meanwhile, the Line Statistics Collector application polls the devices once a day on a sched
basis to retrieve the statistical data collected. It stores the accumulated data on the TEAM 
workstation so that it can be output to other applications for display and use. The Line Statis
Collector application also creates and administers a group of files for each device from whic
collects statistics.

Application Windows

When you launch the Line Statistics Collector application, it displays its main Line Statistics
Collector window and provides access to additional subordinate windows, which are describ
detail in subsequent paragraphs:

• The Line Statistics Collector  main window sets and executes the collection 
processes. The window can be reduced to a desktop icon after setup. This icon will disp
green while all units respond successfully to polling. It will change to red if any units do n
respond

• The Session Security window, associated with the padlock icon, is used to enable
disable session security. When the padlock icon on the main window is displayed in the l
position, the system is guarded against accidental termination of the statistics collection
process.

• The Status Log window, associated with the status log icon, displays a record of start
completion times for each day’s polling activities. The log identifies any unit that fails to 
respond when polled. 

• The Status Log icon is green when all units have responded to polling; thus, the lo
contains only start and completion times.

• The Status Log icon is red when the log contains no response entries. 

• The Group Selection  window, associated with the Select/View Group  button, 
allows the user to specify which SC553 devices statistics will be used to collect statistics
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Line Statistics Collector Main Window

The Line Statistics application first displays its main window, shown below. Use this window
configure and control the collection process. Figure 6-7 and Table 6-5 describe the menus, 
subordinate windows and selectable options for this application. Procedures follow the table

Figure 6-7 Line Statistics Collector Main Window

Note In the Collection State display fields, the button that corresponds to the task’s current state will be gray

Note When the Session Security option is enabled, the padlock icon will display in the locked position. In thi
whenever a locked icon, the Disable Collection  button, or an Exit  menu selection is clicked, the 
application will prompt for a password before activating these functions. The application will not honor t
commands unless the correct password is supplied.

Note When all collection tasks are functioning properly the Status Log icon will display green. It turns red w
any of the tasks malfunction, such as failure to respond to polling. 
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Collection Types
When the user selects 15 Minute Intervals for 7 days , the application records seven
days of statistics as individual 15-minute interval counts. For each monitored device, this typ
collection involves a group of 672 files (one for each interval). Thus, 48,384 bytes of storage
capacity is required. Each day, the application replaces 96 files each day for each device.

When the user selects 24 Hour Totals for 60 days , the application records 60 days of 
statistics as 24-hour total counts. For each monitored device, this type of collection involves a
of 60 files (one for each day). Thus, 4,320 bytes of storage capacity is required. Each day, t
application replaces one file each day for each device. 

Note You can configure the application to perform both types of collection on the same device. For both typ
oldest 24 hours of data is deleted each day when the application collects new data and when the ma
amount of data has been stored.

Table 6-5 Line Statistics Collector Selections

Selections Field Description

Collection Task Session Security icon Advances to a popup window for controlling session security 
(Password activated). 
   Open padlock indicates that the session security is disabled. 
   Closed padlock indicates that session security is enabled.

Equipment Type Pulldown list of eligible devices (i.e., SC 553)

Collection Type Specifies that the application will collect and store statistics in 
according to one of two collection types:
   15 Minute Intervals for 7 days
   24 Hour Totals for 60 days 

Select View/Group button Advances to the Group Selection Window for specifying which 
units will be polled for data.

Task Start Time Hour, AM/PM Specifies the time at which polling will start each day. 

Task Output Directory Specifies the directory that is to hold the data files 
accumulated by polling.

Output File Prefix Specifies the beginning characters of each file name. The 
application will supply the remaining characters.

Message Display Provides a description and guidelines for created output files.

Task Control Collection State Read-only display of application state: 
     Collection Enabled, Collection Disabled or Actively 
Collecting

Task Control buttons Click to Enable or Disable Collection.
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Group Selection Window

The Group Selection window is accessed at the Line Statistics main window by clicking on t
Select/View Groups  button. Use this window to specify which SC553 devices will be us
for polling and collecting statistics. When the application automatically adds new SC553 uni
the TEAM universe, use this window to remove any units from which you do not want to col
statistics. Table 6-6 describes the Group Selection window. 

Table 6-6 Line Statistics Group Selection Window

Selections Field Description

Collection Task Equipment Type Read-only display of eligible device type (i.e., SC 553)

Collection Type Read-only display of selected collection type: 
   15 Minute Intervals for 7 days
   24 Hour Totals for 60 days 

Shelves column Displays a list of selectable shelves containing SC553 units.

Cards column Displays a list of selectable cards by slot location.

Command buttons Select All button Selects all cards and all shelves which contain SC553 units.

Deselect All button Deselects all cards and all shelves which contain SC553 units.

Close Activates the selections and dismisses the Group Select 
window.
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Line Statistics Collection Setup Procedure

1. In the Root map, select the TEAM universe icon by clicking on it so that it is highlighted.

2. Select Line Statistics Collector... from the Performance menu. The main Lin
Statistics Collector window appears. 

3. Click on the Equipment Type  selection field and select the type of device from which 
statistics are to be collected. 

4. Click on the Collection Type  selection field and select either 15-minute intervals for 
seven days or 24-hour totals for 60 days. The message display changes to describe the 
Collection Type. 

5. Click on the Select/View Group  button. The Group Selection window appears, as sho
in Table 6-6, displaying the Equipment Type and Collection Type that you are configuring

6. In the Shelf column, click on the selection box for each shelf from which you intend to co
statistics. You can select multiple shelves. As each shelf is selected, entries appear in the
column for all units of the chosen Equipment Type that are present in the selected shelv
Individual units also have selection boxes. 

7. In the Cards column, select the individual units from which statistics are to be collected.
the Select All and Deselect All buttons near the bottom of the window for 
convenience. 

8. When all selections have been made, click the Close  button at the bottom of the window or 
leave the window open while you turn your attention to the main window. 

9. Use the Task Start Time  selection fields to specify the time at which collection of 
statistics is to take place each day. 

Note You may want to schedule collection to occur during a period when data traffic is expected to be ligh
particularly if statistics are to be collected from a large number of shelves. 

10. Click in the Directory field to get a cursor, and type the appropriate directory path. 

11. Click in the Output File Prefix field to get a cursor, then type a name for identifyin
the statistics files. The application appends each filename with information on when the 
statistics were collected. 

12. Click on the Enable Collection  button to activate the process. To activate the lock 
feature, proceed to the following paragraphs for descriptions and procedures on the Ses
Security Control Window.

13. IMPORTANT: Do not exit the Line Statistics Collector application after setup is complete
The application must continue to run in order to carry out its polling and collection functi
If desired, reduce the window to a desktop icon. 
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Application Considerations
Each file the application records contains one line of data for each polled device. The format
data line is as follows, with commas separating the three ID items and seven statistical item
comprise each line of data:

Date - Time,Shelf ID,Slot Id, ES, BES,SES, UAS,CRC,LFC,CSS

When a poll results in an errored response or no response at all, the data line contains the v-1  
for each of the seven statistics categories, as shown in the example below:

Date - Time,Shelf ID,Slot Id, -1, -1, -1, -1, -1,  -1, -1

When a poll is successful but the polled device had not collected valid data, the data line sto
the application will be as follows:

Date - Time,Shelf ID,Slot Id,65535,65535,65535,65535,65535,255,0

Note The polling procedure can take as much as a minute for each device being polled. Therefore it is adv
to schedule data retrieval to occur at a time of reduced data traffic such as late at night. 

Note Once the Line Statistics Collection application is running, it will automatically add to the continuous 
collection process any compatible units from newly discovered shelves. If you do not want to collect da
these any of these automatically added units, you need to deselect them at the Group Selection wind
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Session Security Control Window

At the Line Statistics Collector main window, the padlock icon appears open while Sessions
Security is disabled. Click on the icon to provide password protection for the statistics collec
process. Table 6-7 describes the control window. Procedures follow the table.

Session Security Procedure
1. At the View menu, select Session Security  or click on the small padlock icon in the 

upper left corner of the window. The Session Security Control window appears.

2. Type in the password you intend to use and click OK. The small window disappears and the 
icon changes to a closed padlock. In this state, when the user clicks the locked padlock 
Disable Collection  button, or selects Exit or Session Security from a 
menu, the application will prompt for the password. 

Note The application will not honor any of the commands described in step 2 unless the correct password
supplied. 

3. To disable Session Security, click on the locked icon or select Session Security  from 
the View menu. In the popup control window, supply the password and click the Disable 
Security  button. 

Table 6-7 Session Security Control Window

Selection Description

Session Security Password A data entry field for setting the security password. 
When Session Security is enabled, this password is required before the 
collection process can be terminated.

OK Saves the entry and dismisses the Session Security control window.
The icon on the Line Statistics main window changes to reflect the new 
security status (locked or unlocked padlock). 

Cancel Cancels the pending changes and dismisses the Session Security 
control window.

Disable Security When clicked, prompts for the security control password.
Incorrect passwords are ignored and security remains enabled.
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Line Statistics Status Log

The Status Log lists all the Statistics Collection tasks that are currently running. Access the 
Log from the main window by selecting Status Log  at the View menu or by clicking the Status
Log icon. The icon is green as long as all collection tasks are functioning properly. It turns red
any of the tasks has a malfunction, such as failure to respond to polling. Figure 6-8 illustrates a 
typical Line Statistics Status Log.

Figure 6-8 Line Statistics Status Window

Status Log Commands
• Click Clear Log  to discard all polling and collection status messages stored on the Sta

Log.

• Click Close  to dismiss the Status Log window.
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